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Workflow
Welcome to the HX Edit Pilot’s Guide. This guide contains details of the HX Edit v2.71 
application’s features and functionality with Line 6® Helix® devices (Helix®, Helix® Rack 
and Helix® LT), as well as with HX devices (HX Stomp™ and HX Effects™). All behav-
iors are the same on Mac and PC computers unless otherwise noted. It is recommend-
ed that you also read the Owner’s Manual for details on using your particular device. 

What’s in it for Me?
HX Edit is a simple, but powerful, editor, preset librarian and IR manager application. It 
allows you to easily customize, backup and manage your tone presets and setlists, as 
well as manage the Impulse Responses on your Line 6 Helix or HX device.
HX Edit is the editor/librarian software for use with all Helix or HX devices that are run-
ning firmware version 2.70 (or later). For best performance, it is recommended to 
use the latest available version of both the HX Edit application and device firm-
ware. If for any reason you wish to use an earlier firmware in your device, or an earlier 
HX Edit software version, you'll need to be sure the release versions of the firmware and 
software match for full functionality.

NOTE: Each Helix or HX device model offers a different set of inputs, outputs and 
signal flow capabilities. Throughout the following chapters, we've indicated HX 
Edit app functionality that is specific to your Helix or HX device type. 

Marketplace
Now open for business is the Line 6 Marketplace online shop, where you'll find 3rd-par-
ty add-on assets that further enhance the functionality of your Helix and HX devices, as 
well as Helix Native plug-in! As of this writing, professionally crafted presets and IRs are 
available - check back often on Marketplace for product news and announcements. An 
Internet connection is required for the computer where you'll be using the HX Edit app 
to authorize it for the use of Marketplace premium assets. Please see “Marketplace & 
Account Options” on page 33.

NOTE: Device firmware version 2.70 and HX Edit version 2.70 or later are required  
for full support and use of premium Marketplace presets and IRs. 

Workflow Overview
Once the HX Edit app is launched, it automatically syncs all presets and IRs from your 
Helix or HX device's internal memory. You'll see your device's presets & IRs displayed 
in the Librarian panels at the left. This allows you to export presets and IRs to create a 
virtually unlimited library on your computer, and then import them onto your device at 
any time. These Librarian panels also allow you to easily rename and reorder your pre-
sets and IRs, and the Backup & Restore feature makes it simple to create full backups 
that can be restored to your Helix or HX hardware in minutes.
You will also see your currently loaded preset's contents displayed in the Editor panels 
on the right. This allows you to load & fully customize your presets, configure bypass 
& controller assignments and create & edit snapshots. While connected, communica-
tion between the application and your connected device’s internal memory is instanta-
neous. Changes you make to any parameters in the Signal Flow or Inspector Windows, 
as well as any changes to presets, setlists and IRs within the Librarian, are immediately 
reflected on the device, and vice-versa.
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This interactive communication allows you to tweak your presets and setlists in real 
time, without the need to send/receive or manually sync to the device.

WARNING: Be careful when overwriting presets or Impulse Responses - these 
changes cannot be reverted! You can use the use the Create & Restore Backups 
feature to backup your Helix or HX device's contents before making changes. See 

“Creating & Restoring Complete Device Backups”. 

Computer Connectivity
To put the HX Edit application to work, connect your Helix or HX device to your com-
puter’s USB 2 or 3 port. 

NOTE: If on Windows®, be sure to have the latest Line 6 driver installed for your 
device: Helix (Helix Floor/Rack/LT Driver), HX Stomp (HX Stomp Driver), or HX 
Effects (WinUSB Driver). You can download the driver installers at http://line6.

com/software/, or simply choose to install the included drivers when you install the 
HX Edit application.  

http://line6.com/support/manuals/
http://line6.com/software/
http://line6.com/software/
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Exit any other Line 6 applications that may be running. With your Helix device 
powered on, launch HX Edit.

•	 Mac: Go to Applications > Line 6 > HX Edit
•	 Windows: Go to the Start button menu > All Apps (or Programs) > Line 6 > HX 

Edit
Upon launch, the application will detect Helix hardware and automatically retrieve and 
display its on-board presets & Impulse Responses. This may take a moment to down-
load all of the preset information. 

Multi-Device, Multi-Window Support
The HX Edit application supports the use of multiple-connected Helix/HX devices si-
multaneously, where each device displays its own full application window. This allows 
you to more easily reference and edit presets and settings, as well as drag and drop 
presets and IRs between multiple USB-connected devices.

TIP: You can also use the Copy and Paste commands or drag and drop to copy a 
block and its current settings from one HX Edit device window to another! 

To access the separate application windows for each connected device, simply go to 
the HX Edit Devices menu and select the desired device to display or hide its window 
- a check mark at the left of a device here indicates its app window is open. You can 
choose to have multiple device windows open simultaneously, making it easy to copy 
and paste blocks, or drag and drop blocks, presets and IRs between them. The sepa-
rate windows can also be resized and/or positioned on your screen independently. 
Please also see “GUI Overview” on page 6.

The app's Devices menu, showing two connected device's windows

You'll see an indicator at the bottom of each application window displaying its con-
nected Helix/HX device type and the device's firmware version - or a warning that no 
device is detected.

Device indicator at bottom of the HX Edit main window

NOTE: On macOS computers, closing all open device windows does not exit the 
HX Edit application. As is common with multi-window supporting macOS apps, 
you'll need to use the Quit HX Edit command from the main HX Edit menu (or 

Cmd+Q). 
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Preset Compatibility
This guide covers version 2.71 of the HX Edit application. The easiest way to ensure the 
best performance and compatibility between HX Edit and your Helix or HX device is to 
make sure to have the latest updates. The latest HX Edit application installer is always 
available free at line.com/software. Use the free Line 6 Updater application to check 
and update your device's firmware (see page 48) . 
Helix preset, setlist and bundle files are compatible and transferable between Helix 
family devices (Helix, Helix Rack and Helix LT), as well as with the Helix® Native plug-in 
software (see next section).* Note that, since Helix LT devices include a more limited 
set of features (smaller I/O set, up to two EXP pedals rather than three, etc.), presets 
created for Helix & Helix Rack devices and Helix Native plug-in may include some un-
available functionality when loaded on a Helix LT device. However, all aspects of the 
preset are retained and available on the other Helix products even after saved with a 
Helix LT device. Please be sure to consult your Helix LT Owner's Manual for its com-
plete feature set.

*NOTE: Presets, setlists & bundles exported from Helix devices (Helix Floor, 
Rack & LT) and Helix Native plug-in are not compatible with HX devices (HX 
Stomp and HX Effects). Likewise, at this time, presets and setlists exported 
from HX devices are not able to be imported into Helix devices or the Helix 

Native plug-in. 
It is possible to Copy and Paste, or drag and drop individual blocks, along with their 
current settings, between Helix Native and HX Edit - including with the use of any 
Helix or HX device. See the following “Block Copy and Paste” section.

Helix presets that were originally created using the earlier Helix editor application and 
Helix device firmware versions are still supported. Note that, once loaded and saved 
with the newer HX Edit application, your presets will have new information added to 
them to support the latest models and functionality - full backward compatibility with 
the Helix application and earlier Helix firmware versions, therefore, cannot be guar-
anteed. It is advised to keep a backup all your earlier presets if you plan on possibly 
returning to these previous device and application versions. 

Preset Compatibility with Helix Native Plug-in
With a Helix Floor, Rack or LT device, your presets, snapshots, setlists and bundles 
are compatible between the HX Edit app and Helix Native plug-in. This compatibility is 
the foundation of the Line 6 “Studio to Stage” concept, allowing you to load, edit and 
transfer your tones between Helix hardware and Helix Native plug-in! Note that Helix 
Native plug-in maintains its own Preset & IR libraries, independent of the presets and 
IRs that reside within your Helix hardware. To share presets from either the HX Edit app 
or Helix Native plug-in, use the export & import features within each.

TIP: If you also own Helix Native plug-in, be sure to reference the “Helix compat-
ible” version number (found in the Helix Native software's About box - see page 
32) to determine the recommended Helix family device firmware version you 

should use for maximum preset compatibility. It is highly recommended to always use 
the latest available device firmware and HX Edit and Helix Native software.

Due to the obvious differences of Helix hardware devices' physical inputs and outputs, 
there are some settings, block type and controller support variances when sharing pre-
sets between a HX Edit and Helix Native plug-in. To follow are tips for sharing presets 
and settings. Please also refer to the latest Helix Native Pilot's Guide for details regard-
ing the use of Helix hardware-exported presets within the Helix Native plug-in. 

HX Edit Backup Files
The HX Edit application includes a feature that creates Helix Backup (.hxb) files to 
restore a Helix or HX device's presets, impulses and global settings (see page 16). 
Helix Native plug-in does not currently include this functionality and, therefore, does not 
support creating or opening Helix Backup .hxb files.

Block Copy and Paste
Using the Copy Block and Paste Block commands, you can copy and paste any block 
type between any presets within HX Edit, as well as between HX Edit (with any Helix or 
HX device connected) and any instance of the Helix Native plug-in. It is also possible to 
drag and drop any processing block to move it within the current preset, or to copy it 
into any other HX Edit device or Helix Native plug-in window. Restrictions apply when 
copying, pasting and moving some block types, depending on the Helix hardware in 
use and the destination - please see “Cutting, Copying, Pasting & Clearing Blocks” 
on page 19.

Snapshot Copy and Paste
The current Snapshot, along with all its settings, can be copied and pasted using the 
Copy Snapshot and Paste Snapshot commands either within the current HX Edit 
preset or the current Helix Native preset, but not between the HX Edit app and Helix 
Native plug-in. Also see “Configuring & Managing Snapshots” on page 15.

Command Center Copy and Paste
Within the Command Center window, once a command assignment is created for any 
footswitch, EXP Pedal or other controller, you can use the Command Center's Copy and 
Paste command options to copy assignments between controllers, as well as between 
controllers within other HX Edit presets. Helix Native plug-in does not include the Com-
mand Center, therefore, it is not possible to copy Command Center assignments between 
HX Edit and Helix Native. Also see “The Command Center Window” on page 29.

http://line.com/software
http://line6.com/support/manuals/
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Input & Output Block Settings
When Importing a Helix Native-exported Preset into Helix Hardware - All input and 
output blocks that were set to “Host” will default to the “Multi” setting within the Helix 
family devices. Any input block set to “None” will remain as set to “None” within the 
hardware. 
When Importing a Helix hardware-exported Preset into Helix Native Plug-in - All 
input and output blocks that were set to physical inputs and outputs (other than “None”) 
will default to the “Host” setting within the plug-in. Any input block set to “None” will 
remain set to “None” within the plug-in. 

Impulse Responses
Impulse Response (IR) files are able to be utilized within IR blocks of the Helix Native 
plug-in just as they are within HX Edit, by way of each application's Impulse Library 
panel. If you are to be sharing Helix presets between Helix Native plug-in and Helix 
devices, it is a good idea to build and maintain your IR libraries similarly on each to 
allow the same IR files to be utilized for your presets that include them - see page 12.

NOTE: IRs, including those from the Line 6 Marketplace online shop and 3rd party 
vendors, are supported by all Helix and HX devices, as well as by Helix Native plug-in. 
Any of your IRs can be imported and exported, as well as dragged and dropped, be-

tween HX Edit and Helix Native IR library windows. 

Controller Assignments
The Helix Native plug-in does not utilize any Bypass, Controller or Command Center 
Assignments that may exist within Helix hardware-exported presets. Helix Native plug-
in simply ignores these assignments, therefore, any such assignments remain intact 
within your presets.* (Snapshot and MIDI In type assignments, however, are supported 
in both Helix hardware and Helix Native plug-in.) Helix Native plug-in includes its own 
functionality to create plug-in parameter - Automation Controller type assignments, 
which are similarly ignored when Helix Native presets are imported into the HX Edit 
application. 

*NOTE: When importing a preset into Helix Native which includes HX Edit-saved  
hardware controller assignments, you'll see the assigned parameter sliders within 
Helix Native display their values in white brackets indicating the assignments. 
Even though these hardware controller assignments are not supported within 
Helix Native, they are preserved with the preset (as well as with the respective, 
individual blocks for copy/paste). Therefore, these assignments will still be intact 
if you import the preset back into HX Edit.  

MIDI In Bypass & Controller Assignments
Using HX Edit, you can create MIDI In Bypass Assignments to remotely toggle the 
bypass state of most block types, and MIDI In Controller Assignments to remotely 
control most Helix parameters, via external MIDI controller devices or MIDI software. 
MIDI In assignments saved within HX Edit-exported presets are supported when im-
ported into Helix Native plug-in. Likewise, MIDI In Bypass and Controller assignments 
saved in Helix Native-exported presets are also supported when the preset is imported 
into HX Edit. Also see “Creating a Bypass Assignment” on page 24.

DSP Limit
In order to maintain preset compatibility with Helix devices, the Helix Native plug-in in-
corporates similar processing management as the DSP management system utilized on 
Helix hardware. That is, the Helix Native plug-in includes a built-in, maximum computer 
processing limit equivalent to the Helix hardware's DSP limit for each preset. This way, 
any preset created and exported from the Helix Native plug-in is ensured to be able to 
be imported and used on Helix hardware devices. 

Marketplace Assets
Premium presets and IRs purchased from the online Marketplace are compatible with 
Helix devices (Helix Floor, Rack and LT) and Helix Native plug-in. (Some Marketplace 
items may be compatible with HX devices, as indicated on the Marketplace site.) The 
import of premium Marketplace assets requires online license Authorization - Please 
see “Marketplace & Account Options” on page 33. 

NOTE: Version 1.70 of Helix Native and 2.70 of HX Edit and device firmware (or 
later) are required for full support and use of premium Marketplace presets and IRs. 
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GUI Overview
HX Edit has a very intuitive, easy-to-use interface. The main application window auto-
matically detects your specific Helix or HX device type and displays all its options within 
the main application window. 

TIP: As covered in “Multi-Device, Multi-Window Support” on page 3, if you 
have more than one device connected, a separate application window is available 
for each device. 

Within the application window, the navigation is divided into three main sections: 
The Librarian Window - For managing preset and Impulse Response (IR) files.
The Signal Flow Window - Where you can add and move amp, effects & mix  
blocks, and customize your complete signal path routing.
The Inspector Window - Where you can choose from the huge selection of mod-
els, edit their parameters, create bypass & controller assignments, and more. 

Show/Hide
Librarian

Impulses
Tab

Presets
Tab

Signal Flow
Window

EDITO
R

LIBRARIAN

Edit TabMy Account/Preferences
Menu

Bypass/Controller 
Assign Tab

Inspector
Window

The HX Edit main GUI (Helix Floor device)

HX Stomp & HX Effects Device Owners: With an HX device connected, its 
application window displays the single signal flow, just as on your HX hardware 
screen. As covered in this chapter for Helix devices, you can utilize the applica-
tion's signal flow to bypass, move, clear, copy & paste blocks, create split 
paths, and more. 

The HX Edit signal flow - with an HX Stomp connected

The HX Edit signal flow - with an HX Effects connected

TIP: The Command Center, for creating MIDI control assignments (Helix and HX 
Effects only) and Global EQ (Helix and HX Stomp only) are available as separate 
windows from the application's Window menu. 

Resizing the Application Window
The HX Edit main application window is resizable, allowing you to adjust it to best fit 
your screen size and workflow. Simply click and drag any corner or edge of the window 
to adjust to the preferred size, or click the “Maximize” button at the top of the window 
to use it in full screen mode. If you have multiple devices connected, each device's ap-
plication window is independently resizable.
It is also possible to show or hide the Presets & Impulses Librarian panel, by clicking on 
the toggle button at the top left of the Signal Flow window. 

The Librarian window Show/Hide toggle button



 7 

Application Menus
At the top of your computer screen (Mac) or top of the application window (Windows), 
you'll find the familiar application menu bar for the current device. Note that the avail-
able commands differ within the File and Edit menus depending on the application 
window, tabbed panel and/or specific control that currently has “focus.” The window 
focus is indicated by a blue outline appearing around the Librarian, Signal Flow or 
Inspector windows.* To change focus, simply click within the desired window, or use 
the TAB key. To follow are descriptions of the included application menu commands 
for Mac and Windows. Also see “Keyboard Shortcuts” on page 36 for additional 
information. 

*NOTE: It is possible that the Librarian's Presets or Impulses tab currently has 
focus, but if you've “hidden” the Librarian panel, you will not see its blue outline 
focus indicator. Using the TAB key will advance the focus to the other windows, 

even when the Librarian is hidden. 

NOTE: On Mac computers, HX Edit has one common, main application menu at the top 
of your screen. If you have multiple Helix devices connected and multiple app windows 
open, all available menu commands & keyboard shortcuts act only upon the current 

“front” application window. (Click on the desired application window to bring it to front.)

HX Edit (Mac only)
•	 About HX Edit - Launches the About box screen, which displays the versions 

of the HX Edit software & connected Helix device firmware.
•	 Preferences - Launches the Preferences window, where you can select applica-

tion options and reference the app's version & legal information - see page 32. 
You can also launch the Preferences window from the My Account menu or from 
the connected device indicator at the bottom of the application window.

•	 Quit HX Edit - Exits the application for all connected devices.

File
When the Presets tab currently has focus (or, when focus is within any window or tab 
except the Impulses tab):

•	 Save Preset - Saves changes for the currently loaded preset to the device's 
Preset Library. 

•	 Import Preset - Imports any .hlx preset file (or files) from your computer, re-
placing the currently selected library preset(s).

•	 Export Preset - Exports the currently selected preset (or presets) and saves 
each to your computer as a .hlx file. 

•	 Import Setlist - (Helix devices only) Imports any .hls setlist file from your com-
puter, replacing the current setlist on your Helix.

•	 Export Setlist - (Helix devices only) Exports the current setlist and saves it to 
your computer as an .hls setlist file.

•	 Import Bundle - (Helix devices only) Imports any .hlb bundle file from your 
computer, replacing all setlists and presets within the Helix.

•	 Export Bundle - (Helix devices only) Exports all the current setlists and their 
presets from your Helix and saves them to your computer as an .hlb bundle file.

When the Impulses tab has focus (or, when focus is within any window or tab except 
the Presets tab): 

•	 Save Preset - Saves changes to the currently loaded preset. 
•	 Import Impulse - Imports an Impulse Response file (or files) from your com-

puter, replacing the currently selected library Impulse(s).
•	 Export Impulse - Exports the currently selected Impulse (or Impulses) and 

saves each to your computer.

TIP: Please see “Presets Panel” on page 9 and “Impulses Panel” on page 
12 for details these File menu commands.

The following File menu commands are available regardless of window focus:
•	 Create Backup - Launches the Create a Helix Backup window, where you can 

export a full backup of your device's presets, impulses & global settings - see 
page 16.

•	 Restore From Backup - Launches the Restore From Backup window, where 
you can restore all your device's presets, IRs & global settings from a previously 
created backup - see page 16.

•	 Preferences - (Windows only) Launches the Preferences window, where you 
can select application options - see page 32. You can also launch the Pref-
erences window from the My Account menu or the connected device indicator 
items at the bottom of the application window.

•	 Quit - (Windows only) Exits the application.

Edit
When the Presets tab has focus:

•	 Copy Preset - Copies the selected Preset(s) to the clipboard.
•	 Paste Preset - Pastes the last-copied preset(s), replacing the preset(s) within 

the selected preset library location(s).
•	 Select All Presets - Selects all Presets within the current Setlist.
•	 Rename Preset - Renames the currently loaded preset.

When the Impulses tab has focus:
•	 Copy IR - Copies the selected IR(s) to the clipboard.
•	 Paste IR - Pastes the last-copied IR(s), replacing the IR(s) within the selected 

IR library location(s).
•	 Clear IR - Deletes the selected the IR(s) from the Impulses library.
•	 Select All IRs - Selects all IRs within the Impulses library.
•	 Rename IR - Renames the currently selected IR.
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When the Signal Flow window has focus:
•	 Cut Block - Copies the currently selected block and its settings to the clip-

board and removes the block from the Signal Flow.
•	 Copy Block - Copies the currently selected block and its settings to the clip-

board.
•	 Paste Block - Pastes the last-copied block's model and its settings to the se-

lected block location. When an existing block is selected as the paste location, 
this replaces the existing block.

•	 Paste Block Before - When an existing block is currently selected, pastes the 
last-copied block's model and its settings to the location before the selected 
block.

•	 Paste Block After - When an existing block is currently selected, pastes the 
last-copied block's model and its settings to the location after the selected 
block.

•	 Clear Block - Deletes the selected block.
•	 Rename Preset - Renames the currently loaded preset.

TIP: Copy Block and Paste Block, as well a drag and drop of processing 
blocks, can be also used between multiple HX Edit windows, and back and 
forth with Helix Native plug-in! See “Cutting, Copying, Pasting & Clearing 

Blocks” on page 19 for details.

Snapshots
•	 Copy Snapshot - Copies the currently loaded preset's snapshot to the clip-

board.
•	 Paste Snapshot - Pastes the last-copied snapshot contents, replacing the cur-

rently loaded snapshot's contents. 
•	 Rename Snapshot - Allows you to edit the title of the currently loaded snap-

shot (Helix and HX Effects devices only).
•	 Snapshots - Any of the current preset's snapshots can be selected directly 

here. (Note that Helix devices offer 8 snapshots, HX Stomp offers 3 and HX 
Effects offers 4.) 

TIP: Please see “Configuring & Managing Snapshots” on page 15 for de-
tails.

Window
•	 Show / Hide Librarian - Toggles the Presets/Impulses librarian panel between 

shown and hidden for the current device window.
•	 Command Center - Displays the Command Center window (Helix and HX Ef-

fects devices only) - see page 29.
•	 Global EQ - (Helix devices only) Displays the Global EQ window - see page 

31.

Help
•	 HX Edit Online Help - Takes you to the Line6.com Support site where you can 

find the latest product documentation.
•	 HX Edit Application Pilot's Guide - Launches the PDF you are reading now.
•	 About HX Edit - (Windows only) Launches the About box, which includes the 

software version and legal credits.

Devices
Displays a selectable option to open or close an individual HX Edit application window 
for each connected Helix or HX device. A check mark appears to the left of each device 
here to indicate when its window is open. Also see “Multi-Device, Multi-Window Sup-
port” on page 3.
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Presets Panel
The Librarian's Presets tabbed panel provides functionality for importing, exporting, 
and managing presets & setlists.

Setlist Commands

Presets Tab

Setlist Menu

Loaded Preset

Selected Preset

Preset Commands

The Presets panel

You'll find the same commands for copying, pasting, renaming, importing, and export-
ing within the application's File & Edit menus. These commands are also accessible via 
“Keyboard Shortcuts”. 

TIP: Helix device presets, setlists and bundles can also be imported and utilized 
within other Helix devices and the Helix Native plug-in! Please see “Preset Compat-
ibility” on page 4 for more info.

HX Device Owners: All functionality described in this chapter is the same for 
use with all Helix and HX devices, unless otherwise noted. At this time, preset 
and setlist files are not compatible between HX and Helix devices or Helix Native 
plug-in - see “Preset Compatibility”.

Premium Marketplace Presets
If you've purchased and downloaded premium Helix or HX presets from the Market-
place, you must be Signed In to your Line 6 account within HX Edit and have your 
computer Authorized to allow HX Edit to initially Import or Export these presets (as well 
as for any setlists or bundles that include premium presets).*

*NOTE: Once you've initially imported your Marketplace assets to sync their li-
censes with your account, you don't need to have HX Edit actively Signed In to use 
them - and it is not necessary to even be connected to the Internet once your com-

puter has been Authorized, except to Deauthorize the computer. Please see “Autho-
rize / Deauthorize Your Computer” on page 35. 

Premium Marketplace presets are otherwise able to be utilized just like any other Helix 
presets. When imported, these premium Marketplace presets are indicated by a guitar 
pick “badge” to their right within the Presets panel.

Premium Marketplace presets are indicated with a golden guitar pick badge

Selecting & Loading Presets
It is important to note there is a difference between the selected and loaded preset 
within the Presets panel.

To Select a Preset - Click once on a preset location in the Presets panel and you'll 
see it become highlighted in gray. This indicates the preset is selected, meaning 
that a preset command (Copy, Paste, Import, etc.) will act upon this preset (even if 
a different preset is the one currently loaded within the Signal Flow).
To Load a Preset - Double-click on any preset (or click once to select it and then 
hit your Enter/Return key) and you'll see the preset with an amber colored highlight, 
indicating it as the preset currently in use. If no other preset is currently selected 
(highlighted in gray), menu commands will act upon this loaded preset, since it is 
effectively also the selected preset. 

TIP: Before editing a preset you may wish to first copy it to another location in the 
Presets panel, or export it to be sure you have an original version of the preset 
before making changes.
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Importing and Exporting Preset Files
Presets are able to be exported to your computer as individual (.hlx) files, allowing you 
to create a limitless collection of tones that can be imported back onto your device's 
internal preset library at any time. 

To Import a Preset File - It is recommended to select an empty “New Preset” 
location within the Presets panel and select the Import Preset command. A brief 
dialog will inform you that importing will overwrite any preset information in the se-
lected location. Click Yes to continue. A system window will display a file browser 
for selecting the preset you wish to import. Once imported, the preset will reside 
on your Helix or HX device's internal memory, within the selected preset location.
To Export a Preset File - Select the preset by single-clicking on it in the Librarian 
- Presets panel and select the Export Preset command. This creates a copy of the 
preset in its last-saved state from your Helix or HX device's memory and saves it to 
your computer. The familiar “save” window is presented, in which you can edit the 
filename and choose a destination folder. By default, .hlx preset files are exported 
to the following directories.
•	 Mac - /Documents/Line 6/Tones/Helix folder
•	 PC - \My Documents\Line 6\Tones\Helix folder

TIP: If you happen to own both a Helix (or Helix Native plug-in) and HX device, it is 
recommended to export your HX Stomp and HX Effects presets into their own, in-
dividual directories to avoid mixing them up with Helix and Helix Native plug-in 

preset files, since they are not compatible at this time.

Renaming, Reordering, Copying and Pasting Presets
These functions allow you to customize your presets within the Presets panel. Choose 
Rename, Copy or Paste from the row of preset command buttons or application's 
Edit menu and it will act upon the selected (highlighted) preset. You can also right-click 
on a preset in the list to open a context menu with these same commands. For most 
commands, it is also possible to multi-select a number of presets by using Shift+Click 
to select a contiguous set of presets, or Cmd+Click (Mac) or Ctrl+Click (Windows) to 
select a non-contiguous set.

TIPS: There is no command to “delete” a preset, but you can right-click on a block 
within the signal flow and use the Clear All Blocks command.

NOTE: Copy and Paste of presets and IRs between HX Edit and Helix Native, or 
between multiple HX Edit device app windows is not currently supported. How-
ever, you can use drag and drop for these actions! See the next section. 

Drag and Drop Presets
It is possible to drag and drop any preset (or multi-selected presets) directly from the 
Presets panel to perform the following actions.

•	 Import and Load - Drag a .hlx preset file from any computer folder and drop 
directly onto a Presets panel slot, or onto the Signal Flow window, to import 
and load it in the app as the current preset. This import action replaces and 
overwrites the previously loaded preset.

•	 Load - Drag any individual preset from its Presets panel location and drop it 
within the Signal Flow window to copy it into the currently loaded preset's slot 
location, overwriting the currently loaded preset.

•	 Export - Drag one or multiple presets from the Presets panel and drop into any 
folder on your computer to export a copy of the .hlx preset file(s) there. 

•	 Reorder - Drop to another location within the Presets panel to reorder the pre-
sets within the list as desired. When the preset is dropped into the new location 
slot, the surrounding presets are shifted upward or downward accordingly.

•	 Copy Between Two Devices - If you have multiple devices connected, it is 
possible to drag and drop presets between the multiple HX Edit device app 
windows' Presets panels, or directly into the Signal Flow, assuming the presets 
are compatible between both device types. (See “Preset Compatibility” on 
page 4.)

•	 Copy To/From Helix Native Plug-in - (Helix devices only) Drag a preset from 
the plug-in's Presets panel and drop directly into the Presets panel of the HX 
Edit app to import and load the preset on your Helix device, replacing and 
overwriting the previously loaded preset. Likewise, you can also drag and drop 
presets from HX Edit into Helix Native plug-in (see “Preset Compatibility” on 
page 4).

Importing and Exporting Setlists
The Presets panel allows you to instantly save the currently loaded setlist, including all 
its saved presets, to a Helix setlist file (.hls). This is very handy for making a backup of 
all presets within a setlist, so that a group of presets can easily be loaded back into your 
Helix in a single action. 

HX Device Owners: A Setlist for your HX Stomp/Effects consists of all presets 
within the device's preset library. Similar to the steps described here for Helix 
devices, you can use the HX Edit Import Setlist and Export Setlist commands, 
found within the app's File menu.

To Import a Setlist - Select the Import Setlist command. This will prompt you 
to ensure that you wish to replace the currently selected setlist and the presets 
therein. Continue through the Open window to select the setlist you wish to load 
onto your connected device.
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To Export a Setlist - Select the Export Setlist command to display the Save As 
dialog. By default, setlists are saved to:
•	 Mac - /Documents/Line 6/Tones/Helix/Setlists folder
•	 PC - \My Documents\Line 6\Tones\Helix\Setlists folder

Changing Setlists
To change the active setlist shown in the Presets panel, click on the Setlist menu and 
choose from among your device's setlists. The currently-selected setlist will be indi-
cated with an “open folder” icon in this menu.

Renaming Setlists
To rename the current setlist, right-click on the setlist name within the Setlist 
menu and type in your desired title.

HX Device Owners: The single Setlist on your HX Stomp/Effects displays no 
name on the hardware or within HX Edit. However, you can edit the Setlist's file 
name when Exporting the file to your computer.

Importing and Exporting Bundles
A Bundle file (.hlb) includes all 8 setlists' contents of your Helix device, including all their 
presets and saved settings, wrapped up in a tidy package.* This makes it easy to export 
to create and store a backup of your Helix device's complete Preset library - and easily 
restore your device's Presets library to your device (or to the Helix Native plug-in) by 
importing the bundle. 

NOTE: Bundle files do not contain any of the Helix device's Global Settings or Im-
pulse Response (IR) files. To include all these Helix items, use the Create & Restore 
Backups feature - see page 16. 

*HX Device Owners: HX Stomp/Effects devices do not support Bundle files, 
therefore, you will see no available Bundle options.

The Import Bundle and Export Bundle options are found in the application's Prefer-
ences > General window (see “The Preferences Window” on page 32). 

Bundle options within the Preferences window (for Helix devices)

To Import a Bundle - Click the Import Bundle button and you'll be prompted 
to replace all setlists and presets within your Preset library. Continue through the 
“Open” window to select the bundle you wish to import. Note that you can option-
ally import any bundle that was exported from the Helix Native plug-in or any Helix 
device.
To Export a Bundle - Click the Export Bundle button to create a copy of all pre-
sets and their last-saved settings that exist in all setlists as a Helix bundle (.hlb) file. 
By default, all .hlb files are saved to:
•	 Mac - /Documents/Line 6/Tones/Helix/Bundles folder
•	 PC - \My Documents\Line 6\Tones\Helix\Bundles folder

NOTE: On the next power up of your device after importing multiple presets, or 
importing any setlist or bundle, you may see your device perform an additional 
“Rebuilding Presets” process during boot up. This process is normal and optimizes 

preset loading times on the hardware. 

TIP: Wanting to restore the Factory Presets & settings for your device? You can do 
so by performing a Factory Restore - please see your Helix or HX device's Owner's 
Manual for details (and remember to use HX Edit to first do a backup of your cur-

rent presets!)

TIP: Visit the line6.com/customtone site to share your tones and download from 
the huge online library of artist and user presets!

https://www.line6.com/manuals
https://www.line6.com/manuals
http://line6.com/customtone
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Impulses Panel
The Librarian's Impulses tabbed panel provides a list of all Impulse Response files 
(along with respective ID numbers in the left column) that currently reside on your Helix 
or HX device. Initially, this Impulses panel is empty, awaiting your import of Impulse 
Response files.

IR Commands

IR Index Numbers
Selected IR

Impulses Tab

The Impulses panel

HX Device Owners: IR files can be used by all Helix and HX devices. All func-
tionality described in this chapter is the same for use with all devices, unless 
otherwise noted.

What are Impulse Responses?
Impulse Responses (or “IRs”) that can be used in Helix & HX devices are audio files that 
are the result of capturing the sound of a test tone (frequency sweep) through a guitar or 
bass amp speaker cabinet, which has been de-convolved with the original tone signal. 
This represents the frequency response of the miked cabinet itself, and can be used to 
simulate the way it alters the sound. This is similar to a convolution reverb, but with a 
much shorter decay. 
Add an IR block to your preset as an alternative to using one of the Cab blocks to 
provide speaker cabinet simulation. Several companies now offer large selections of 
professionally recorded IR files that can be used in Helix devices, or you can even do 
some research on how to record and create your own.
You can also find some IRs that were created using this convolution process to capture 
the properties of acoustic guitar bodies, guitar pickups and other sources. These IRs 
can certainly be used in the Helix IR blocks as well, to allow even deeper tone sculpting! 

TIP: Line 6 offers a free pack of excellent IRs from Allure - you can grab them now 
at http://line6.com/allure/. 

You can also find a great selection of IRs, specifically created for Helix products, on the 
Marketplace - see page 33.

IR Formats and Restrictions
For all Helix and HX devices, as well as Helix Native plug-in, the following IR file types 
are supported.

•	 Helix Impulse Response (.hir) - This is the proprietary Line 6 IR file format. All 
IRs purchased through the Marketplace are of this file type. (Please also see 
“Marketplace & Account Options” on page 33.)

•	 WAV (.wav) - Most IR producers and vendors typically offer IRs within the .wav 
format. It is possible to import a mono or stereo .wav file IR, regardless of its bit 
depth, length, or sample rate frequency. While this is very convenient, please 
be careful to import only .wav files that were created specifically for use as IRs, 
not just any audio .wav file, or you may experience unexpected sonic results.

Helix Native Plug-in Users: If you plan on utilizing your Helix presets on both a 
Helix device and Helix Native plug-in, the best practice to import the same exact IR 
files into both, and in the same IR list order. This allows all IR blocks to reference and 

load the same indexed IR files for all presets that use them. Please also see “Preset 
Compatibility with Helix Native Plug-in” on page 4. 

Importing and Exporting Impulse Responses
To access the IRs stored on your Helix or HX device, click on the Impulses tab. From 
here you will be presented with a list of up to 128 IRs and their index numbers. Your 
presets will access these IRs by their IR list index number only. The IR files themselves 
are not directly associated with presets, only the IR's index number, as shown at its left, 
is referenced.

NOTE: Premium Helix IRs purchased from Marketplace are also imported & ex-
ported using the following steps. It is required that you have Authorized your com-
puter, and that you are Signed In to your Line 6 account in HX Edit to initially Import 

or Export them. Once imported into HX Edit, no active Internet connection is necessary 
to utilize your Marketplace IRs. Please see for “Marketplace & Account Options” on 
page 33 details.

To Import an IR, first select the desired index location in the application's Impulses 
panel and select Import. Select the desired IR .hir or .wav file you wish to load onto 
your device. It is also possible to select multiple IR files and all will be imported in one 
action. 

http://line6.com/allure/
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When premium Marketplace IRs (.hir files) are imported, they are indicated by a golden 
guitar pick “badge” to their right within the Impulses panel.

Premium Marketplace IRs are indicated with a golden guitar pick badge

To Export an IR, click Export to display the Save As dialog.
By default, IRs are saved to the following directories.

•	 Mac - /Documents/Line 6/Tones/Helix folder
•	 PC - \My Documents\Line 6\Tones\Helix folder

You can also drag and drop to and from the Impulses panel to export and import IRs - 
see the following section.

TIP: Use the File menu's Create Backup & Restore From Backup options to 
create a backup of your Impulses Panel's contents, and restore from the backup, at 
any time - see “Creating & Restoring Complete Device Backups”.

Renaming, Copying, Pasting & Clearing IRs
These actions can be performed by clicking the commands above the Impulses list 
view and will act upon the selected (highlighted) IR. You can also right-click to choose 
these options from the context menu (or use the app's “Keyboard Shortcuts”).

NOTE: Copy and Paste of presets and IRs between HX Edit and Helix Native, or 
between multiple HX Edit device app windows, is not currently supported. How-
ever, you can use drag and drop for these actions! See the next section. 

Drag and Drop IRs
There are several drag and drop options that allow you to import and export single or 
multiple IR files between your computer’s directories and HX Edit, as listed below. 

•	 Import - Drag one or more IR files from your computer folder directly into the 
Impulses panel. When multiple files are being dragged in, they are imported  
starting with the selected IR index slot. 

•	 Export  - Select one or more IR index locations and drag from the Impulses list 
view directly to your computer to export the IR files to the selected hard drive 
folder.

NOTE: When exporting IRs from the HX Edit IR panel, any Marketplace 
purchased IR is saved to your computer as a Helix IR (.hir) type file. The .hir 
files are proprietary to Line 6 products, and licensed to you via the  Line 6 
Account on which you purchased them. Any IR that was originally imported 
as a .wav file is exported as a .wav file. 

•	 Copy - It is also possible to drag and drop IRs within the Impulses list view to 
create a copy of the IR in a new index location.*

*NOTE: There are no options offered to move or reorder IRs in a single opera-
tion, thereby reducing the risk of unintentionally breaking the link between IRs 
and the Helix presets that may be referencing them. Use the Copy, Paste and 

Clear functions to rearrange IR within the Impulses list as needed. 

•	 Copy Between Helix / HX Devices - If you have multiple devices connected, 
it is possible to drag and drop IRs between the multiple HX Edit device app 
windows' Impulses panels to copy them between devices.

•	 Copy To/From Helix Native Plug-in - With an instance of the Helix Native 
plug-in open, drop IRs from the HX Edit application's Impulses panel directly 
into the Impulses panel of the Helix Native. It is also possible to drag IRs from 
Helix Native directly into the Impulses panel of HX Edit to import copies of the 
same IRs.

Loading an IR in an IR Block
When you insert an IR block within your preset's Signal Flow, it initially defaults to ref-
erencing the IR that resides within the #1 IR index location (if you have not yet imported 
any IR file into the referenced index location, the “empty” IR block has no effect on the 
signal). 
To choose which IR index is referenced by the IR block, select the IR block within the  
Signal Flow, then, in the Edit tab, use the IR Select parameter slider (or its menu at the 
right) to select IR index number (1-128) that includes the desired IR. 

Choosing an IR by its Library (1-128) index number within the Edit tab

You can use the other IR block parameter sliders in the Edit tab to further shape the IR's 
tone and level - see “Editing Model Parameters” on page 22.
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Working in the Editor
The Editor portion of the HX Edit user interface consists of the Signal Flow and Inspector windows. The Signal Flow Window is where you'll see the signal paths for your currently-
loaded preset, appearing much like the Home screen of your Helix, or Signal Flow screen of your HX device. The Inspector Window below contains 2 tabbed panels, Edit & Bypass/
Controller Assign, where you can select models, tweak parameters, configure controllers and more. Regardless which of these tabs you have selected, the current preset's Name Field, 
Save, Snapshots & Tempo options are always available at the top of the window. Additionally, there are dedicated windows for the Command Center for MIDI assignments (Helix & HX 
Effects only - see page 29), and the Global EQ (Helix & HX Stomp only - see page 31), accessible from the application's Window menu. If you have not already done so, be sure 
to read through the in-depth information in your device's Owner's Manual to get an understanding of the features we'll be covering in the following sections.

HX Device Owners: HX Edit application functionality described within this chapter is the same with Helix or HX devices, except where noted.

Preset Name Field Preset Save Button Snapshots Menu Tempo Controls

Edit & Bypass       
Controller Assign Tabs

Signal Flow Window

Librarian Show/Hide
Button

Inspector Window

The Editor portion of the HX Edit application (Helix device)

http://line6.com/support/manuals/
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Naming & Saving the Preset
The Preset Name field at the top of the Editor displays the title of the currently loaded 
preset. Double-click on the text here to optionally rename the preset. For Helix devices, 
whenever you see your preset's title appearing in italicized text at the top of the Signal 
Flow window, it indicates that the preset has been edited from its last-saved state. 

HX Device Owners: Since preset functionality differs slightly on HX devices, 
you will not see the current preset's title displayed in italics when in an unsaved 
state.

The Save button at the top of the Editor can be used to save the currently-loaded 
preset, overwriting the preset that resides within the respective Presets panel slot. As 
covered in “Presets Panel” on page 9, there are also the Librarian window options, 
Copy and Export, to create & store copies of your presets. 

Configuring & Managing Snapshots
Your device offers the ability to configure the 8 snapshots within a Helix preset (or 3 
snapshots of HX Stomp preset, or 4 snapshots of an HX Effects preset), allowing you 
to recall a customized set of options for your current blocks instantly, without the brief 
lag time associated with changing presets! A snapshot is capable of storing the bypass 
state of any amp or effects block, up to 64 assigned parameter values, tempo settings 
and more (please see your device's Owner's Manual for specifics). 
There are two ways to select a snapshot within HX Edit: by clicking on the Snapshots 
menu at the top of the Edit window, or by using the commands within the application's 
Snapshots menu. To edit its settings, select the numbered snapshot you want as your 
destination, then configure the desired tone options for this snapshot.*

The Edit window's Snapshots menu The menu bar's Snapshots menu

*NOTE: You can use your device's Global Settings > Preferences > Snapshot 
Edits to choose between Recall (automatically stores your changes to the current 
snapshot) versus Discard (does not store changes to the current snapshot). 

The camera icon within the Edit window's Snapshots menu is displayed in red  
when the hardware's option is set to Discard.

Once your desired destination snapshot has been selected, us the following steps to 
configure your settings. 

To Store a Block's Bypass State Per Snapshot - Click on the Bypass button 
above any block within the Signal Flow and set your desired bypass state for the 
block (or you can toggle the block's Bypass button within the Edit tab).  
To Store a Parameter's Min. & Max. Values Per Snapshot - Select the desired 
block within the Signal Flow, then right-click directly on the desired parameter's 
slider within the Edit tab and choose the Snapshots controller option. This effec-
tively creates the snapshot assignment for the parameter. You can then go to the 
Bypass/Controller Assign tab, select the snapshot assignment you just created 
within the Controller List, and customize its Min. & Max. sliders and other available 
options in the Inspector at the right. We cover more about configuring these con-
troller options in “The Bypass/Controller Assign Tab” on page 23.
To Store a Command Center MIDI Message Per Snapshot - The Value parame-
ters of any instant MIDI CC, Bank/Prog, and MMC message, plus the state (Dim or 
Lit) of any CC Toggle and Ext Amp messages are always stored and recalled when 
selecting a snapshot. Therefore, there is no need to manually set any of these pa-
rameters to a Snapshot assignment within the Command Center - see page 29. 

Attention Helix Native Plug-in Users: Snapshot settings are compatible within 
presets between Helix, Helix Rack & Helix LT devices and the Helix Native plug-in! 

Copying, Pasting, Renaming & Customizing Snapshots
The Copy, Paste and Rename Snapshot commands are available within the app's 
main menu. Or, (for Helix or HX Effects devices) right-click on the Edit window's Snap-
shots menu to access these commands as well as the LED color customization options. 

The context menu for the Snapshots menu name field (Helix or HX Effects devices)

To Copy & Paste a Snapshot - It is possible to copy all the settings of one snap-
shot and paste them to another snapshot within the same preset. Select and load 
the snapshot you wish to copy and select Copy. Then select and load the snap-
shot you wish to overwrite and choose Paste to paste the clipboard contents, 
replacing the currently loaded snapshot. 

http://line6.com/support/manuals/
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To Rename a Snapshot - (Helix and HX Effects devices only) Right-click the de-
sired snapshot from the Snapshots menu and select Rename Snapshot. Type in 
your new name, then press Enter/Return on your keyboard.
To Customize a Snapshot's LED Color - (Helix and HX Effects devices only) When 
your device is set to Snapshot footswitch mode, each footswitch LED defaults to a 
red color. If you prefer to customize the LED color for the current Snapshot, choose 
the desired color from the right-click menu. Or choose Auto to restore the default 
behavior, or Off for no LED.

NOTE: Remember that you'll need to Save before switching to another preset to 
retain your edited snapshot settings within the current preset! The snapshot that is 
in use when you save your preset is the one that is recalled when the preset is 

loaded again.

Editing the Tap Tempo
There are a few options available for configuring the tempo, accessible from the Tempo 
Controls at the top of the Signal Flow window. Any of the current preset’s effect models 
set to note division values will follow this Tap Tempo value. (Note Sync mode is avail-
able for most delay and modulation effects - see page 22.)

Tempo Select 
Menu

Tap Tempo 
Button

      The Tempo Controls

How the Tempo Value is Recalled
Use the Tempo Select Menu to choose how the tempo value is saved and recalled 
(this is the same option found in your Helix or HX hardware's Global Settings > MIDI/
Tempo screen):

•	 Per Snapshot - The tempo value is stored and recalled individually per snap-
shot for the current preset.

•	 Per Preset - The tempo value is stored and recalled individually with this preset.
•	 Global - The tempo value is used for all presets whenever set to Global.

NOTE: Your Helix device's tempo can also be configured to follow MIDI Clock from 
an external source, accessed from within your device's Global Settings > MIDI/Tempo 
screen. When your device is actively following MIDI Clock, all options for the Tempo 

Controls are disabled and the Tempo value displays as “[External].”

Entering a Tempo Value
To enter a value, click on the Tap Tempo Button rhythmically, or right-click directly on 
the Tap Tempo button and type in your desired numerical value.

Creating & Restoring Complete Device Backups
Use the File menu's Create Backup and Restore From Backup commands to create 
complete backups of your Helix or HX device's current Global Settings, IRs, and Pre-
sets, and easily restore them back to your device at any time. All presets are backed 
up from their last-saved state, therefore, be sure to save your currently-loaded preset 
before creating your backup to include its current settings.

NOTE: If you have purchased and imported Marketplace premium presets or IRs, 
your computer must be in the Authorized state to be able to use the Create Backup 
and Restore From Backup features, if the backup includes Marketplace premium 

assets. See “Authorize / Deauthorize Your Computer” on page 35. 

TIP: Backup files (.hxb) created using the Create Backup feature any Helix (Helix 
Floor, LT or Rack) device can then be “Restored” onto any other Helix device. This 
allows you to easily duplicate all your applicable Global Settings, Presets, and IRs 

to another Helix in one action.
Backup files created for HX Stomp devices are compatible only with 
HX Stomp type devices, and HX Effects backup files are compatible only 
with HX Effects type devices.

To Create a Backup
Select the Create Backup command from the File menu to launch the window.

The Create Backup window (Helix device)

1.	 Name - Your backup file is automatically named with the type of device (Helix 
Floor, Helix Rack, Helix LT, HX Stomp or HX Effects) and the current date. Op-
tionally, you can click directly on the file name here and edit it as desired.



 17 

2.	 Description - Optionally, you can type in some descriptive notes about this 
backup. All text added here is saved with your backup, and viewable during the 
Restore From Backup process.

3.	 Where - By default, your Backup file (.hxb) is saved to the following  directory 
on your computer:
•	 Mac - /Documents/Line 6/Tones/Helix/Backups folder
•	 PC - \My Documents\Line 6\Tones\Helix\Backups folder

If you wish to save to a different folder, click the folder button and browse to 
select your preferred disk location.

4.	 Click Create Backup and you'll see the progress of your backup being created, 
and a message once completed successfully (or click Cancel to exit without 
creating a Backup).

You can repeat the above steps at any time to create as many individual back-
ups as you like. All compatible backup files for your connected Helix or HX are 
then available within the Restore From Backup window.

TIP: It is highly recommended to create a full Backup before installing device firm-
ware, and to perform backups regularly to make sure you always have copies of 
your tones, IRs and settings! 

To Restore From a Backup
Select the Restore From Backup command from the File menu to launch the window.

The Restore From Backup window (Helix device)

1.	 Backup Folder - The default or most-recently used Backup folder is selected 
here. If you want to find a backup file in a different folder, click the folder button 
to browse to the desired location.

2.	 Backup File - All compatible Backup files (.hxb) that you created within the cur-
rently selected directory are selectable here. When you select a backup file, the 
following information is displayed so you know the details about the backup 
before you choose to restore from it.
•	 Date: The creation date of the backup file.
•	 Device: The specific type of Helix device this backup was created from (Helix 

Floor, Helix Rack, Helix LT, HX Stomp or HX Effects).
•	 Version: The firmware version installed on the device when the backup was 

created. 
•	 Description: Any notes that you entered within the Description field when the 

backup was created appear here.

3.	 Items to Restore - In the lower pane, you can select the individual items you 
wish to be restored from the selected backup file: Global Settings, Impulse Re-
sponses and Presets. Whichever items you select here will be restored, over-
writing those currently on your Helix device.

TIP: For Helix, Helix Floor & Helix LT devices, note that by clicking on the arrow 
to the left of the Presets checkbox, you can expand the option (as pictured 
above) to individually choose whichever Setlists you want to restore from the 

selected Backup!

4.	 Click Restore Backup and you'll see the progress of the restore process, and 
then a pop-up message once completed successfully (or click Close to exit 
without restoring). Do not disturb the HX Edit application or device until the 
Restore process is complete.

TIP: If the Backup that you restored included any Presets or Setlists, it is a good 
idea to power your device off and on again to allow it “rebuild” the presets. This 
process optimizes preset loading times on the hardware.  

You can repeat the above steps at any time, and select any available Helix or HX 
Backup file stored on your computer. 
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The Signal Flow Window
The Signal Flow window allows you to directly access the Amp, Effects, Mix & Looper 
blocks within your preset and configure your signal path routing simply by clicking and 
dragging. Once you select any block within the Signal Flow, the Inspector's Edit tabbed 
panel below provides access to all its editable parameters. The options offered here are 
essentially the same as found on your connected Helix or HX device, making editing 
very straight-forward.

HX Device Owners: HX Edit application functionality described within this chap-
ter is the same with Helix or HX devices, except where noted.

Split BlockPath 1A

Path 2A

Path 1B Merge  - Mixer Block

The Signal Flow Window (Helix device)

Split BlockPath 1A Path 1B Merge-Mixer Block

The Signal Flow Window (HX Stomp device)

Split BlockPath 1A Path 1B Merge-Mixer Block

The Signal Flow Window (HX Effects device)

Show/Hide Block Labels Option
If you prefer a cleaner look within the HX Edit app's Signal Flow window, you can “hide” 
the descriptive text labels that appear below each block using the Show/Hide option 
within the Preferences > General window (see page 32). When set to hide the 
labels, you'll only see a block's label appear when hovering your mouse over the block.

Block Label Option Set to Show Block Label Option Set to Hide

Moving Blocks & Arranging the Signal Flow
To move blocks within a signal path, click and drag any block to its desired location. To 
follow are a number of pointers for arranging the signal flow in different ways.

HX Device Owners: You'll see only the HX Stomp/Effects device's single Path 1 
displayed within the HX Edit signal flow panel. The HX Path 1 can be similarly 
split to offer parallel Paths 1A and 1B, as shown in the preceding screenshots.

Path 1 / Path 2 (Helix devices only) - Unlike on the Helix hardware, within HX Edit 
it is possible to Copy a block, including its current settings, between main Paths 1 
and 2 via drag and drop. You can also Cut or Copy a block and then Paste into any 
desired location on the opposite path to re-locate it there, along with its settings 
intact - see next section. 
Split Paths - To create a split path, simply drag a block down from the main signal 
path (Path 1A or Path 2A) and you'll see a parallel, split path (Path B) appear, with 
both a Split and Merge block created at each end (as shown in above image). To 
remove the split path, clear or move all blocks out of the parallel “B” path. 
Mix (Split and Merge-Mixer) Blocks - When a Split block is selected in the Signal 
Flow, you can choose from among 3 types of Split blocks, and adjust the balance 
options using the parameter sliders that appear in the Edit tab below. Note that you 
can click and drag the Split and Merge-Mixer blocks to position them however you 
like within the path. 

TIP: You can also Copy and Paste blocks between presets, between HX Edit and 
Helix Native and back, and with any Helix or HX device - see page 19.

Split Path Options
Functionality for Split blocks and Paths differ slightly for Helix vs. HX devices, as de-
tailed here.

Helix, Helix Rack & Helix LT Devices
If you drag a Split block down from Path A (or right-click on the Split block and choose 
Create Input), it will change into a separate Input block for Path B, which then offers a 
set of Input block options in the Edit panel. Likewise, if you drag a Merge block down 
(or right-click on the block and choose Create Output), it becomes a separate Output 
block for Path B. When dragged to Path B, the Split or Merge-Mixer block becomes 
inactive and no longer affects either of the signal paths.
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This functionality is how you can potentially create up to 4 individual signal paths within 
one preset, each with its own input and output settings, as shown below. Once con-
verted to Input & Output blocks, you can drag the inactive Split or Merge-Mixer block 
back up to the main Path A to restore each back to an active Split or Merge-Mixer block 
(or use the right-click options to Restore them).

Inactive Merge-Mixer blocksInactive Split blocks

Split paths converted to individual paths (Helix device)

HX Stomp and HX Effects Devices
On HX devices, once a parallel path is created, the Split block can be dragged left or 
right on Path A to re-position it as desired. (But unlike with Helix devices, a Split block 
cannot be moved down to convert it into a separate Path B Input.) 
It is possible to drag the Path A Merge-Mixer block down (or right-click on the block 
and choose Create Output), as shown in the following screenshot. This routes the Path 
B output separately to the hardware Send 1/2 output jacks, and the Merge-Mixer block 
becomes inactive in this Path B position. 
Once converted to an output, drag the inactive Merge-Mixer block back up to the main 
Path A to restore the split path and active Merge block (or use the right-click option to 
Restore it).

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Merge-Mixer block routed to Path B Send Output (HX Stomp device)

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Merge block converted to Path B Send Output (HX Effects device)

Cutting, Copying, Pasting & Clearing Blocks
You can use the Cut Block or Copy Block commands for an existing processing (Amp, 
Cab, IR, FX or Looper) block, and then use one of the Paste Block commands to paste 
it, with all its current settings, into a new location within any path and within any preset. 
Use Clear Block to remove the selected block from the path. Once you've selected the 
desired block, these commands are accessed either from the menu bar's Edit menu, or 
from a block's (right-click) context menu (or via keyboard shortcuts - see page 36). 

Block Cut, Copy, Paste & Clear commands are available in the Edit menu or block's context menu

TIP: You can also use Copy/Paste, or drag and drop, to copy a block between  
separate HX Edit device windows, as covered below.

Use Cut Block or Copy Block and then any of the Paste Block commands in either 
HX Edit or Helix Native plug-in, as follows:

•	 Into any path within the same or a different instance of the Helix Native plug-in, 
and within any preset

•	 Into any path within the HX Edit app, and within any preset
•	 Into any preset within HX Edit when then connected to a different Helix or HX 

device (as long as the copied Block data is the last item copied to your com-
puter's clipboard)

•	 Into an additional HX Edit application window - also see “Multi-Device, Multi-
Window Support” on page 3

Block Cut / Copy / Paste is allowed for all block types (Amp, Effects, Mix, Input and 
Output blocks), with some restrictions.* This provides great flexibility in re-creating 
tones between Helix Native, HX Edit, and even different Helix & HX devices.

*NOTE: Some restrictions apply for Copy / Paste of blocks, depending on the DSP 
capacity and features of the particular device in use. For example, just as any Helix 
Native plug-in or device preset will prevent adding some block or model types as 

the DSP limit is reached, the same DSP limit rules apply for Copy / Paste. Presets can 
also include only one Looper block, one use of each Send & Return, up to two IR 
blocks, etc. Therefore, Copy and Paste observes these Block rules as well. Physical 
inputs & outputs differ between Helix Native and Helix/HX devices, therefore, the copy-
ing of Looper, Mix, Input and Output blocks and their settings may not be allowed, as 
covered throughout this chapter.



 20 

Cut Block - Clears the block from the Signal Flow and copies the block and its 
current parameter settings to the clipboard.
Copy Block - Copies the block and its current parameter settings to the clipboard. 
Paste Block - Pastes the most recently cut or copied block to the selected des-
tination. If you select an existing block, this will replace the existing block and its set-
tings. To follow are a few handy copy & paste tips.

•	 Paste Block After / Paste Block Before - If you select an existing block, you 
can alternatively choose either of these commands to paste the block in your 
preferred location. All these Paste Block commands are selectable within the 
main Edit menu, as well as from a block's right-click context menu.

•	 Mix type blocks (Helix devices only) - Copy & Paste are also available for any 
Input, Output, Split and Merge type block as well, where its settings can be 
copied & pasted into a location with the same block type. (When copying these 
blocks between different device types, which may include unique parameters 
per device, only common parameters are pasted.)

•	 When copying a block within the same window, or between separate HX Edit 
(and/or Helix Native) windows, all existing assignment types are copied with the 
block, except for any footswitch-based Bypass assignment.*

•	 When copying a block from HX Edit to Helix Native, it may not appear that 
its hardware-based controller assignments are retained, since the Helix Native 
does not support them, and does not list them in its Assignments tab. But if you 
copy the same block back into an HX Edit window again, you'll see its original 
assignments are indeed still intact.*

*NOTE: When copying a block with existing hardware-based assignments, the as-
signments will not be retained if the destination device does not include or support 
the specific controller type (e.g., if copying a block with an EXP 3 controller assign-

ment from a Helix Floor to an HX Stomp device, the assignment is not shown or sup-
ported, since HX Stomp includes no EXP 3).

Clear Block - Choose Clear Block from the application's Edit menu, from the 
block's (Right-click) context menu, or by clicking the “X” button that appears when 
you hover your mouse cursor over a block. Alternatively, you can select an exist-
ing block in the Signal Flow and choose None from the Edit tab's Model Browser. 

When hovering over a block, you'll see its Bypass and Clear buttons appear

Clear All Blocks - Available in the block's context menu, this removes all process-
ing blocks from the signal flow. (Input & Output block settings remain unchanged.)

NOTE: Only one Looper block can exist within any preset at a time. Therefore, you 
cannot Copy and then Paste a Looper block within the same preset. But you can 
use the Cut Block command and then Paste Block to effectively “move” a Looper 

block, including its settings, to a new location, such as to a different path.  

Drag and Drop Blocks
You can also use “drag and drop” to copy/paste a block within the current preset, as 
well as between separate HX Edit and/or Helix Native windows, as follows.

•	 (In HX Edit with Helix Floor, Rack or LT devices, or in Helix Native) Within the 
current window’s signal flow - drag and drop of a block between path 1 and 
path 2 copies the block to the opposite path. (This differs from dragging a block 
within the same or parallel path, which moves the block.)

•	 Between separate HX Edit instances and/or Helix Native windows -  Drag and 
drop copies the block, to any path.

•	 Drag and drop can be used to copy any processing type blocks (Amps, Cabs, 
IRs, FX).

•	 Since performing a drag and drop of a block between separate windows is 
essentially the same as a Copy/Paste Block operation, the same rules and be-
haviors apply - please see the preceding section.

NOTE: When dragging a block, if you try to drop it on top of an existing block, you'll 
see the existing block shift left or right to place your dragged block before or after 
it. Unlike when using the Copy and Paste commands, it is not supported to replace 

an existing block via drag and drop.

Adding & Bypassing Blocks
To Add Any Type of Block to Your Tone - Simply hover your mouse cursor over 
the desired location on any path and you'll see an empty “None” block location ap-
pear. Once you select the location, choose any type of block from the Model List 
Menu in the Inspector's Edit tab below (see the following chapter for more info). If 
you select a location already occupied, choosing a different model from the menu 
will replace the selected block's model.
To Toggle the Bypass of a Block - Do any of the following:
•	 Hover your mouse cursor over a block within the Signal Flow and use the 

Bypass button that appears above the block. 
•	 Right-click on the block and choose Bypass from the context menu.
•	 Click on the desired block to select it, then use the Bypass button within the 

Edit tab.
•	 Click on the desired block to select it and hit the Spacebar. 
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The Edit Tab
The Inspector window's Edit panel provides access to all models via its multi-level Model 
Browser, where you can choose from numerous categories of models to make up your 
tone. This panel also displays all available parameters for the block that is currently se-
lected within the Signal Flow window, providing easy access for editing. 

HX Device Owners: HX Edit functionality described in this chapter is the same 
for all Helix and HX devices, except where noted. 

Selecting Models
As mentioned in the previous chapter (page 20), add models to your current preset by 
selecting the desired empty location on any path within the Signal Flow window and then 
choose the specific model you want from the Model Select Menu. You can also select any 
existing block within the Signal Flow and change its model this way.

 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders
The Edit Panel's Model Browser

Choose the type of block first in the Category List at the left to see all of its available 
models appear in the Model List. Note that, once you've selected a Category, you can 
toggle List/Grid View toggle button to change between a menu list or grid type display 
of the category's models. 

HX Effects Owners: HX Effects devices do not include Helix Amp, Preamp or 
Cab type models, therefore, these categories will not be available. 

Model List view Model Grid view
For block categories that offer it, you'll see a sub-category menu at the top of the Model 
List, where you can choose to see Mono, Stereo or Legacy type models. Amp categories 
offer Guitar & Bass sub-categories, and for Cabs you'll see Single & Dual category options. 
Once you click on any model in the Model List it is instantly active and loaded into the se-
lected Signal Flow location. You'll see the selected model's editable parameters appear 
at the right of the Edit panel. If you want to remove an existing block, select it within the 
Signal Flow and choose the None category's Empty Block option (or use the Clear 
Block menu command).

DSP Limit
As in your Helix or HX device's Model Select menu, when the current preset reaches a 
high DSP usage, some models become non-selectable within the menu. In the HX Edit 
app's menu, you'll see models dimmed to indicate this, as shown below. To free up more 
DSP resources for the current preset, try removing some models, or selecting “Simple” 
or “Legacy” type models. For Helix devices, utilize both Path 1 and Path 2 to take advan-
tage of all available DSP power. (See the DSP Management information within your device's  
Owner's Manual for details.)

Dimmed models 

Unavailable models appear dimmed when the preset's DSP limit is reached

NOTE: Also see “Preset Compatibility” on page 4 for relevant information 
about DSP limits and the use of Helix presets with the Helix Native Plug-in. 



 22 

Editing Model Parameters
Once added to your tone, simply click on any block to select it, then choose the desired 
model type and tweak its parameters in the Edit panel. To follow are a few editing tips 
(also see “Keyboard Shortcuts”).

Toggling Model Bypass - A Bypass button is available at the top right of the Edit 
panel for any model that offers a bypass option. When a model is bypassed, its 
parameters appear dimmed to indicate this state.  

Edit tab - model active Edit tab - model bypassed

Adjusting Parameter Sliders - There are several ways to adjust slider values:
•	 Click on any slider's “handle” and drag to the desired value.
•	 Click on the desired range location within a slider's path and it will jump to the 

clicked value.
•	 While hovering your mouse cursor directly over any slider's path, use your 

mouse wheel to adjust it.
•	 Click the up/down arrow buttons at the right for small, incremental adjustments. 

If a down arrow is displayed at the right, click on it to expand its menu.

Type in a Precise Value - Double-click anywhere on a slider's path or on its value 
to manually type in a precise numerical value.
Resetting Sliders - If you're not happy with your slider adjustment, Cmd+Click 
(Mac) or Ctrl+Click (Windows) on the slider to reset it to its initial default value.
Accessing All Parameters - Note that some model types, such as amps and 
complex effects, may have more sliders and controls than you can see all at once 
in the Edit tab. You can re-size the application window to show more sliders, or 
click and drag the vertical scroll bar at the right to access all parameters (or use 
your mouse wheel when hovering your mouse cursor over the scroll bar).

Note Sync - Most modulation and delay effects models offer a Note Sync option, 
allowing the modulation rate or delay repeat time to follow the device's main Tap 
Tempo value (see “Editing the Tap Tempo” on page 16). For models that offer it, 
you can click the Note Sync button within the Edit tab to toggle the feature on/off. 
When active (the Note Sync button is lit), the parameter will change to offer note 
division values, as shown in the following screenshot. 

Note value options Note Sync (active)

A Delay block configured for Note Sync

Impulse Response Block Options - When an IR block is selected in the Signal 
Flow, you'll see IR block parameter sliders here in the Edit panel, just like for any 
other block. Use the IR Select parameter to choose the index number for the de-
sired IR from your IR Library. Remember that you'll need to import IR files into your 
Helix or HX device using the application's Impulses tab for an IR block to utilize 
them - see “Importing and Exporting Impulse Responses” on page 12.
Looper Block Options - It is possible to add a Looper block to a preset, and view 
and edit several Looper block parameters within the Edit tab. However, it is not 
possible to toggle the Looper mode of your connected device on and off within the 
HX Edit application.

TIPS: Right-click on a slider for a handy menu to assign external control of the 
parameter to one of your Helix or HX device's controllers, or to an external MIDI 
controller - also see page 26. Alt+Click directly on slider in the Edit tab to in-

stantly create a Snapshot Controller Assignment for the parameter - see page 15.

Editing Input, Output, Split & Mixer Blocks
Much like Amp & Effects blocks, you can click on the Input, Output, Split or Mixer 
blocks of any path and access their options in the Edit panel. 

Input Block Options: 
•	 Helix and HX Stomp Devices -  Different parameters, such as Gate, Level, 

Pan, etc., are displayed depending on the specific input type you select from 
the Input block's menu. If the Multi or Variax input type is selected (available 
on Helix devices only), you'll see options here for selecting a Variax model, in-
dividual string tunings, and more. 

•	 HX Effects Devices - The path's input is “fixed” and, therefore, is not select-
able and does not offer block options.

Output Block Options:
•	 Helix Devices - When the Output block of any path is selected, you'll see 

output routing options available. In addition to your Helix device's analog and 
digital outputs, you can also choose to route the output of one path to the input 
of another later path. Note that you can route the output of Path 1 into Path 2 in 
a “serial” fashion to take advantage of both paths' DSP capacity! 

•	 HX Stomp and HX Effects Devices - When a split path is created, the Mixer 
block can be dragged down to Path B to create a separate “Send” output (see 
“Split Path Options” on page 18). When this dual-output, split path configu-
ration exists, you can click on the Path A (Main) output or the Path B (Send) 
output to access Pan and Level parameters for each. The HX Stomp Path B 
output additionally offers a Mono/Stereo option.

Split Block Options - If your preset includes a split path, click directly on the point 
on the main path where the signal divides to select the Split block and you'll see 
options for choosing different Split block types and their parameters. Note that 
there is also a Bypass switch for Split blocks which, when bypassed, feeds an  
equal signal balance to each parallel path.
Mixer Block Options - If your preset includes a split path, click directly on the 
point on the main path where the signal returns to select the Merge-Mixer block 
and you'll see several mixer options for blending the two paths' signals.
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The Bypass/Controller 
Assign Tab
This tabbed panel combines the options found within the Controller Assign screens of 
your Helix or HX device (as well as the options within the Helix and HX Stomp devices' 
Bypass Assign screens), allowing you to assign model parameter functions to your 
device's footswitches & expression pedals, or external MIDI controllers for real-time, 
remote control. It is also possible here to assign model parameters to be stored and 
recalled with snapshots, as well as to customize footswitch labels and LED colors.

HX Device Owners: HX Edit functionality described in this chapter is the same 
for all Helix and HX devices, except where noted. 

TIP: For creating & managing assignments for the transmission of MIDI commands 
from your (Helix or HX Effects) device's footswitches and pedals, see “The Command 
Center Window” on page 29.  

In addition to the options for creating assignments, a list of existing bypass & controller  
assignments for the current preset appears within the left portion of this panel, allowing 
you to select and edit assignment options. (This handy display of existing assignments 
in one list is something not found on your Helix or HX device's screens.) 

Column HeadersAssignment List Selected Block

Selected Assignment Bypass/Control 
Parameters

Footswitch/Controller 
Menu

Assignment Menu

The Bypass/Controller tab

Attention Helix Native Plug-in Users: The Helix Native plug-in's Automation/
Controller Assign panel supports a different set of controller assignments (for use 
with host DAW software's parameter automation). Therefore, Helix Native will es-

sentially ignore any HX Edit-created hardware controller assignments saved in a preset 
- see “Preset Compatibility” on page 4. 

Editing an Existing Assignment
When working with Factory Presets, you'll see that most already have some existing 
assignments, and they appear within the Assignments List at the left of the Bypass/
Controller Assign tab (see previous image). Once you create your own Bypass & Con-
troller assignments, you'll see them appear within this list as well. At any time you can 
select an assignment within the list to see and edit its options, as described below. 
Please also refer to the following examples for creating specific assignments types for 
more info.

Clearing Existing Assignments
If you right-click directly on any existing Bypass or Controller assignment within the 
Assignment List, you'll find handy options for deleting the selected or all assignments.

The Clear Assignment options within an assignment's context menu

Clear Assignment - Deletes the assignment that you clicked on. 
Clear All Assignments - Deletes all Bypass and Controller assignments that exist 
within the current preset.

Minimum & Maximum Sliders
Use the Min & Max sliders to set the range of control. For example, if creating a con-
troller assignment utilizing an EXP Pedal, the Min setting equates to the pedal's “heel 
down” value, and the Max to its “toe down” value. If assigning to a footswitch, clicking 
the switch toggles between your configured Min & Max values. (Note that if assigning to 
a snapshot, all you need to do is set the single parameter value you wish to be recalled 
with the currently-loaded snapshot.)

TIP: You can “reverse” the behavior of a controller by setting the Min to 100% and the 
Max to 0% - such as to make an assigned Wah pedal work backwards!  

Latching/Momentary Footswitch Option
For Amp & Effect models, you'll also find the Type option here to have the assigned 
footswitch behave as Latching (alternating On/Off on each click) versus Momentary 
(active only while the footswitch is held down).
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MIDI CC In Selector
For assignments that offer remote control via external MIDI, this parameter is where 
you need to define the specific MIDI CC value (CC 0-127) to match the MIDI CC value 
being transmitted from your external MIDI controller device or MIDI software. Your MIDI 
hardware or software must be capable of sending MIDI CC messages via 5-pin MIDI 
cable or USB to your Helix or HX device.* 

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN jack 
or over USB. Use the device's Global Settings - MIDI Tempo options to configure 
its receiving MIDI channel and other MIDI options. 

Switch LED Option
(Helix and HX Effects devices only) By default, the color of the LED light surrounding 
your assigned footswitch is set to Auto Color, where it intelligently takes on the color 
according to the assigned model type. You can optionally use this slider to manually 
configure this LED color as desired.

Customizing a Footswitch Label
(Helix and HX Effects devices only) For any selected Bypass or Controller assignment 
that is created using your device's Footswitch, you'll see a Customize control dis-
playing the block model's default name. This is the label displayed on the hardware's 
scribble strip for this footswitch (or on the LCD screen for a Helix LT device) when the 
Helix device is in Stomp Footswitch Mode. If you want to customize this label, double-
click on the existing name, type your new text in the field and hit your Enter/Return key. 
To clear your text and return to the default model label, click the Clear (eraser) button 
to the right of the field.

The Customize label control

NOTE: On Helix and HX Effects Devices, if a footswitch includes one or more ad-
ditional block Bypass, Controller or Command Center assignments, the default 
label appears as Multiple (X) with “X” being the number of assignments. You can 

customize the label in this scenario, but note that it can also be customized within the 
Custom field of the other assignment panels as well, with the latest customization edit 
affecting the label in all places. 

Creating a Bypass Assignment
Create a Bypass assignment for any Amp, Cab, IR, Effect, Looper or Split type block to 
allow it to be toggled on/off via one of your Helix or HX device's footswitches, control-
lers or via external MIDI.

NOTE: On Helix devices, adding a Volume Pedal, Pan, Wah, or Pitch Wham block 
automatically creates a Bypass assignment to the Helix on-board pedal's EXP Toe 
footswitch. On HX devices, a Bypass assignment is automatically created for these 

block types on EXP 1 / EXP 2. You can change or clear this assignment if desired - see 
“Editing an Existing Assignment” on page 23.

Creating a Bypass Assignment Using a Footswitch 
1.	 Click on the block within the Signal Flow for which you want to create the Bypass 

assignment. 

2.	 At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3.	 Click on the Footswitch/Controller Menu to select the desired footswitch or 
controller and your assignment is created. 

Selecting a footswitch controller for block Bypass assignment

TIP: Alternatively, right-click on a block within the Signal Flow and choose the desired 
Footswitch or Controller to quickly create a Bypass assignment.  

Creating a Bypass Assignment Using an External MIDI Controller Source
It is also possible to configure a block to be controlled remotely via an external MIDI 
controller switch, or via MIDI software on your DAW computer. All that is required is that 
the MIDI controller is capable of sending MIDI CC messages via 5-pin MIDI cable or 
USB to your Helix or HX device.* 
A MIDI - Bypass assignment can be created independently of a Helix or HX hardware 
controller source assignment for the same block. You will only see one Bypass assign-
ment entry displayed within the HX Edit app's Assignments List, regardless if it includes 
an active MIDI assignment source, hardware controller assignment source, or both.
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*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN or 
over USB. Use the device's Global Settings - MIDI Tempo options to configure its 
receiving MIDI channel and other MIDI options. 

1.	 Click on the block within the Signal Flow for which you want to create the MIDI-
In Bypass assignment. 

2.	 At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3.	 Set the MIDI In parameter to match the MIDI CC number (0 - 127) that your ex-
ternal MIDI controller is sending. To “disable” the MIDI assignment, simply set 
this parameter to Off.

Setting the MIDI In's CC number for a bypass assignment

Your configuration is now complete and your external MIDI source should suc-
cessfully toggle the selected block's Bypass. You'll also see the CC number you 
selected shown in the Assignment list's Source column (“MIDI In 11”).

TIP: Alternatively, you can utilize the Learn (MIDI Learn) feature within the Bypass 
Assign screen of your Helix or HX device to create a MIDI Bypass Assignment.  

NOTE: With Helix and HX Effects devices, you can use CC67 to toggle the Bypass 
of any 6 Switch Looper block. This is a pre-defined, global MIDI CC hardware as-
signment that does not appear within the HX Edit Bypass/Controller Assign panel. 

Creating a Bypass Assignment Using an Expression Pedal
It is also possible to assign a block's Bypass to an Expression pedal (or to a Variax 
knob on Helix devices). An example of this is to configure a Wah block so that resting 
the pedal at the “heel” position toggles the effect off, and then moving the pedal away 
from this position to use the Wah automatically activates the effect again. Set this type 
of configuration using the following steps.*

*HX Effects Owners: On HX Effects, this type of EXP 1 - Bypass configuration 
is configured automatically for any Wah or Pitch Wham type block you add to 

your tone, and to EXP 2 for any added Volume/Pan block. You can follow these steps 
to manually create an EXP Pedal - Bypass assignment for any type of block. 

1.	 Start by adding a Wah block to your tone and selecting it within the Signal Flow. 

2.	 If using a Helix device with an on-board EXP 1 pedal, move the pedal forward 
and click the Toe Switch so that it is set to EXP Pedal 1, and the Wah block is 
active.

3.	 On a Helix or HX Stomp device, since the Wah block is already automatically as-
signed to the EXP Pedal Toe switch for bypass, you'll need to change its Bypass 
assignment to EXP Pedal 1 instead. 

Select the Wah block in the Signal Flow view and go to the Bypass/Controller 
Assign tab. Select the existing Bypass assignment in the list at the left, then 
select the EXP Pedal 1 controller from the Controller/Switch menu at the right.

 
Selecting an expression pedal controller for block bypass assignment

4.	 Once the assignment is created, you can configure its option sliders at the right 
of the panel.  

Configuring an expression pedal - Bypass assignment options

•	 Position - For a Bypass assignment, this determines the position of the con-
troller where the block's bypass is triggered. Set this slider to 5% or lower to 
establish a “heel down” resting position to trigger your bypass toggle.

•	 Wait - Determines the duration of time for which the assigned controller must 
rest at the configured Position value before the bypass is triggered. For this 
type of Wah Bypass assignment, 300 ms is generally a good setting, since it 
prevents unwanted bypass triggering during the typical use of the pedal for 
your Wah effect.

Once configured, you'll see that your EXP 1 pedal's heel down position toggles 
the Wah block off, and as soon as you move the pedal, it activates the Wah until 
you move the pedal back to the Min heel position and rest it there for 300 ms 
or more (as determined by the Wait slider). You can choose to configure other 
blocks' parameters with a “pedal bypass” using these same steps as well.
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Bypass Assignments for Multiple Blocks
For Helix & HX hardware, you can only assign the Bypass toggle of any particular block 
to one footswitch at a time. If a block already has an existing Bypass assignment and 
you change the assignment, this will move the assignment to the newly selected foot-
switch or controller. But it is possible to assign the Bypass function for multiple blocks 
to one common footswitch or controller for simultaneous switching. 
Each Helix or HX device's footswitch or controller can have up to 8 assignments. You 
can additionally create Controller and (on Helix or HX Effects) Command Center assign-
ments utilizing footswitches that simultaneously include Bypass assignments. It's also 
possible to create snapshots that include multiple Bypass & other parameter changes 
all in one click - see the respective sections for more on these assignment types!

TIP: A handy trick is to create a multi-bypass assignment to toggle one block off and 
the other on simultaneously, such as to change between two different distortions, be-
tween two different amps, etc. To reverse the switching, select one block within the 

Signal Flow and manually click its Bypass button so that one block is the opposite bypass 
state as the other. Now whenever you toggle the assigned Bypass footswitch, both blocks' 
bypass states are toggled oppositely. 

Creating a Controller Assignment
Just as on your Helix or HX device's Controller Assign screen, you can create a Con-
troller assignment for practically any block's parameter to allow it to be controlled by 
a remote device's footswitches or controllers, or by external MIDI gear. Here in the 
Bypass/Controller Assign tab you can also configure a Snapshot assignment, to allow 
your desired parameter settings to be stored & recalled with a preset's snapshots. 

Creating a Controller Assignment Using an EXP Pedal or Footswitch
1.	 Click on the block within the Signal Flow that includes the parameter for which 

you want to create the Controller assignment. 

2.	 At the right of the Bypass/Controller Assign panel, click the Assignment menu 
and choose the parameter to control - for this example we'll choose the Mix of 
a 70s Chorus block.

Selecting a Chorus block's Mix parameter for controller assignment 

3.	 Click on the Switch/Controller menu to select the desired controller and your 
assignment is created. We'll choose the EXP Pedal 1, but you can alternatively 
choose any EXP Pedal (or, if using a Helix device, one of the Variax Knob con-
trollers). It is also possible to choose one of your device's Footswitches as the 
controller, which allows you to then configure a specific parameter value for 
each of the two states of the footswitch. More on this in the final step.

Selecting an EXP Pedal controller for controller assignment

TIP: Alternatively, right-click on the Mix slider for the 70s Chorus within the Edit tab 
and choose the desired controller from the slider's context menu to quickly create a 
Controller assignment.  

4.	 Once you've created the Controller assignment, you'll see it appear in the list at 
the left of the Bypass/Controller Assign tab. Select the assignment in the list to 
access options specific to the type of controller you've chosen. For EXP Pedal 
and Variax Knob controller types, there are options for the Min and Max, which 
allow you to limit the range of the assigned parameter as you move the pedal or 
knob controller from minimum to maximum position. For our example, we'll set 
the Max slider to 50% so that it achieves a 50% wet/dry Mix balance when our 
controller is moved to full open.

Configuring options for an EXP Pedal controller assignment
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If you have chosen a Footswitch as your controller rather than an EXP Pedal or 
Variax Knob, you'll have a few more options, as described below.

Configuring options for a footswitch controller assignment

•	 Type - Choose the footswitch behavior:
•	 Latching - Press and release the footswitch to toggle between the “On/Off” 

states.
•	 Momentary - Press and hold and the footswitch. While held down, the “On” 

state of the switch is active. While released, the “Off” state is active.
•	 Min and Max - Configure these two sliders to the specific values you'd like the 

“Off” and “On” footswitch states of the assigned footswitch to toggle between. 
•	 Switch LED - (Helix and HX Effects devices only) Customize the color of the 

LED that surrounds the assigned footswitch on your device. 
•	 Customize - (Helix and HX Effects devices only) You can edit the name that ap-

pears for the assigned footswitch label on your device by clicking in this field. 
To return to the default label, click the eraser button.

Creating a Controller Assignment Using an External MIDI Controller Source
It is also possible to configure a block's parameter to be controlled remotely via an 
external MIDI controller device, or via MIDI software. 

1.	 To configure a parameter for external MIDI control, you can essentially use the 
same steps as in the above controller assignment example. However, in step 3 
you will want to select MIDI CC from the Footswitch/Controller Menu.

Selecting MIDI CC as the controller type 

2.	 Once the assignment is created, configure the Min & Max sliders to limit the 
range of the assigned parameter control, if desired. You then need to set the 
MIDI CC In slider value to match the MIDI CC number being sent from your 
external MIDI source - if this value does not match the MIDI CC being sent, the 
parameter will not respond.

Configuring a MIDI CC assignment's options

Your configuration is now complete and your external MIDI controller source 
should successfully control the selected 70s Chorus - Mix parameter. You'll also 
see the assigned CC number shown in the Assignment list's Source column 
(“MIDI CC 16”) for reference.

TIP: Alternatively, you can utilize the Learn Controller (MIDI Learn) feature within the 
Controller Assign screen of your Helix or HX device to create a MIDI  Controller as-
signment.  

Creating a Snapshots Controller Assignment
Configure a block's parameter with a Snapshots assignment to allow the parameter's 
settings to be stored & recalled with a preset's snapshots. 

1.	 Since a Snapshots assignment is simply one type of controller assignment, you 
can follow the same steps 1 and 2 from “Creating a Controller Assignment Using 
an EXP Pedal or Footswitch” on page 26 to select the block within the Signal 
Flow, and then choose the desired parameter in the Bypass/Controller Assign 
tab's Parameter Menu. 

2.	 In the Controller Menu, choose Snapshots.

Selecting the Snapshots controller type
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TIP: Click on the desired slider within the HX Edit Edit tab and use the “Alt+click” or 
“S” keyboard shortcuts to instantly create a Snapshots controller assignment.  

3.	 Unlike with other controller types, you won't see any options in the right of the 
Bypass/Controller tab for a Snapshots controller assignment. 

A snapshots assignment is created - there are no configurable options for this assignment type

With this assignment created for the parameter, simply choose the desired  
snapshot from the Snapshots Menu at the top of the HX Edit application win-
dow, and then whatever value you set for this parameter is automatically stored 
and recalled with the snapshot. This allows you to configure up to 8 different 
values on Helix devices (or 4 values on HX Effects, or 3 values on HX Stomp) for 
each preset - one for each available snapshot. Please see your device's Owner's 
Manual for details on using snapshots. 

Multiple Controller Assignments
Just as on the hardware, you can only assign a parameter to one Controller at a time. 
However, it is possible to assign multiple parameters to one common Controller, (for ex-
ample, to simultaneously control the Mix parameters of two effects with an EXP Pedal 
to blend between them). It is also possible to create additional Bypass assignments 
and/or Command Center assignments on footswitches that also include Controller as-
signments - see the respective sections for more on these assignment types.

NOTE: (Helix and HX Effects devices only) If a footswitch includes one or more 
additional block Bypass, Controller or Command Center assignments, the default 
label appears as Multiple (X) with “X” being the number of assignments. You can 

optionally customize the footswitch label - see “Customizing a Footswitch Label” on 
page 24. 
The footswitch label can also be customized within the Customize label field within the 
Command Center window, with the latest customization edit affecting the label in all 
places. See the next chapter.

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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The Command Center 
Window
To display the Command Center window, select it from the application's Window menu. 
This window offers the options found within the Helix or HX Effects devices' Menu - 
Command Center screen, allowing you to create MIDI output assignments (and CV 
output assignments for Helix devices) to remotely control other gear from your device. 
Please refer to your Helix or HX Effects Owner's Manual for details on the types of com-
mands supported and their options. Many of the Command Center window functions 
are also accessible using keyboard shortcuts - see page 36.

HX Stomp Owners: HX Stomp devices do not include the Command Center fea-
ture. HX Edit functionality described in this chapter is the same for all Helix and 

HX Effects devices, except where noted. Please refer to the MIDI chapter within your 
HX Stomp Owner's Manual for details on its MIDI functionality.

Command Menu

EXP Pedals

Instant Commands Variax Knobs 

Footswitches

EXP Pedal Toe Switch Selected Controller

Inspector Done Button
The Command Center window (Helix Floor device)

NOTE: The application's Command Center window will show Control selector 
items specific to your device. For example, as shown above, the Helix Floor device 
offers more hardware options for controller assignment (Variax Knobs, 3 EXP 

Pedals, and a Pedal Toe switch), than are available with an HX Effects.

Attention Helix Native Plug-in Users: Helix Native does not include the Com-
mand Center or support for creating or customizing these types of commands. 
However, existing Command Center assignments are retained even after load-

ing, editing or exporting presets with Helix Native. Also see “Preset Compatibility with 
Helix Native Plug-in” on page 4.

Creating a Command Center Assignment
Click directly on any Control Selector item (Instant , Footswitch, EXP Pedal or 
Variax Knob) for which you want to map an assignment. Then, in the inspector pane 
at the right portion of the window, click on the Command menu to choose the type 
of message you wish to transmit from this control. Once a command type is selected, 
configure its options using the parameter sliders that appear. Once you save, these 
Command Center settings are stored individually with the current preset.

You'll see a turquoise triangle indicator above the control items that include an assign-
ment. To remove an existing assignment, select the control item again within the Com-
mand Center window and choose None from the Controller menu, or right-click and 
choose one of the Clear Command options from the context menu.

Assignment Indicators

Copying, Pasting and Clearing Commands
Just as on your Helix or HX Effects device, there are options available to easily Copy, 
Paste and Clear Command Center assignments. Using these commands from the ap-
plication's Edit menu, or from the individual controls' right-click context menu, you can 
copy and paste an assignment from one controller to another, copy & paste all com-
mand assignments within the current preset to another preset, clear the current com-
mand assignment, or clear all of the preset's current command assignments. 

The Command Center context menu's Cut, Copy Paste & Clear commands

It is also possible to paste within the Command Center window for any other preset, 
even if a different Helix device is connected to the HX Edit application while your last-
copied command data still exists on the clipboard. At this time, it is not possible to 
utilize the Copy All Commands and Paste All Commands options between different 
devices.*

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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*NOTE: The different Helix device types offer varying sets of Command Center as-
signment options, therefore, unsupported commands cannot be copied between 
different Helix devices (e.g., Helix LT and HX Effects devices do not offer an EXP 3 

controller, thus it is not possible to paste an EXP 3 command assignment from a Helix 
floor to these devices).

To Cut, Copy or Clear - Simply right-click on the desired instant , Footswitch, EXP 
Pedal or Variax Knob controller item that includes the assignment and choose the com-
mand from the context menu. 

•	 Use Cut if you want to clear the assignments of the selected Control Select 
item, and also copy the assignments to the clipboard.

•	 Use Copy All if you want to copy the complete set of existing Command Center  
assignments within the current preset and you can then load a different preset 
and use Paste All Commands within its Command Center window to copy all 
in one action.

•	 Use Clear All if you want to wipe out all the Command Center assignments 
from the current preset and start clean.

To Paste - Once you've copied Command Center assignment data to the clip-
board, right-click on your desired destination controller item (within the same pre-
set, or in another) and choose the Paste or Paste All option. 

Configuring Unique Assignments Per Snapshot
It is possible to configure your Command Center assignments with specific command 
values that differ within each snapshot, allowing a great deal of message variety pos-
sibilities within a single preset. The message types supported by snapshots include 
the Value parameters of any instant MIDI CC, Bank/Prog, and MMC message, plus the 
state (Dim or Lit) of any CC Toggle and Ext Amp messages. Please refer to your Helix 
or HX device's Owner's Manual for details on the types of Command Center messages 
that can be stored & recalled with a snapshot, and their specific behaviors.
To store your assignment settings within a snapshot, first select the desired snapshot 
index number from the Snapshots menu at the top of the app's Editor window, and 
then open the Command Center and edit the eligible values of your existing Control 
Center assignments that you wish to be stored. The settings are automatically retained 
per snapshot. Be sure to save your preset once your edits are complete. (Also see 
“Configuring & Managing Snapshots” on page 15.)

Customizing a Footswitch Label
When you create a Command Center assignment to the selected footswitch control 
within the Command Center window, you'll see the Customize field available within the 
parameter display at the right. 

You can customize text in this field to determine what is displayed on the hardware's 
footswitch scribble strip (Helix Floor, Helix Control, and HX Effects devices), or on the 
footswitch display block when in Stomp Mode (Helix LT devices). To clear your text and 
return to the default label, click the Clear (eraser) button to the right of the field.

Clear buttonCustomize label field

NOTE: If the footswitch includes one or more additional block Bypass, Controller or 
Command Center assignments, the default label appears as Multiple (X) with “X” 
being the number of current assignments. You can customize the label in this sce-

nario, but note that it can also be customized within the Custom Label field of the 
Bypass/Controller Assignment tab as well, with the latest customization edit affecting 
the label in all places. 

Customizing a Footswitch LED Color
When the selected footswitch within the Command Center window includes any type of 
Bypass, Controller or Command Center assignment, the color of the LED on/off indica-
tor light surrounding your footswitch can be customized to your color choice using the 
Switch LED slider/menu at the right.* 

The Command Center - Switch LED parameter

The options are as follows:  

•	 Choose one of the 10 colors
•	 Auto Color -  The LED intelligently takes on the color according to the assigned 

model type. 
•	 Off - The LED remains unlit, regardless of the switch state.

*NOTE: This option is also found within the Bypass/Controller Assign panel - cus-
tomizing an LED in either will overwrite the LED's current settings. 

http://line6.com/support/manuals/
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Global EQ Window
The Global EQ, accessed from the application's Window menu, offers a large graphical 
interface for the Helix device's Global EQ. As its name suggests, the Global EQ set-
tings and bypass state are indeed global and not saved or recalled with any preset or 
snapshot. HX Edit functionality described in this chapter is the same for all Helix and HX 
Stomp devices, except where noted.

HX Effects Owners: HX Effects devices do not include the Global EQ feature. 

Bypass Button

Done ButtonLevel Slider

Reset Button

Inspector Pane Band Parameters

Apply EQ Output Menu

Band Edit Nodes

The Global EQ is a 5-band, parametric style equalizer, situated after all other process-
ing blocks of your Helix or HX Stomp signal path, allowing for sculpting your overall 
tone just before it is sent out your Helix (1/4" and/or XLR) or HX Stomp (Main 1/4") 
outputs. This is especially handy for fine-tuning your tone to compensate for a venue's 
stage or room sound, without having to go in and tweak all your presets.

Adjusting Global EQ Parameters
The Global EQ window offers two methods in which you can view & adjust its set-
tings: by dragging any band's edit “node” within the graph, or by adjusting the selected 
band's parameter sliders within the lower inspector portion of the window. The EQ 
processing is functional whenever its Bypass button is set to “active” in this window (or 
via your device's Bypass button when viewing its Global EQ screen). 

Reset - Click the Reset button to instantly return all parameters to their default, 
“flat” values.
Apply EQ Output Menu - (Helix devices only) Select your Helix device's output(s) 
on which you want the Global EQ to be active.
Bypass Button - Toggle the Bypass to globally enable or disable the EQ.
Band Edit Nodes - Click and drag the desired band's Edit Node in the upper 
graph to adjust its Frequency and Gain. You'll also see the respective parameters' 
sliders move within the inspector pane while adjusting any edit node.
Inspector Pane - This lower portion of the window offers a set of adjustable pa-
rameters for each of the EQ's five bands.
Band Parameters - Each band has its own set of sliders. Note that the Low Cut 
and High Cut are “shelving” type filters, allowing you to set the roll-off point for the 
low and high frequencies respectively. The middle 3 bands are fully parametric, 
with controls for choosing the center Frequency, Gain (with a boost or cut of up 
to 12dB), and Q (the width of the frequency range affected). Adjust the sliders as 
follows:
•	 Click and drag any slider's handle or use the Up/Down buttons at the right of 

each slider
•	 Right-click on a slider to enter a precise value numerically 
•	 Turn your mouse wheel while hovering your cursor over any slider
•	 Click on a slider and use the comma/period or -/+ shortcut keys to incremen-

tally adjust its value 
•	 Double click on a slider to individually reset it to its default value

Level Slider - (Helix devices only) Adjusts the post-EQ output level, offering a 
“make-up gain” to compensate for the overall output level change incurred by EQ 
parameter settings.
Done Button - Click to close the Global EQ window.

TIP: Try the handy keyboard shortcuts for adjusting Global EQ options - see page 
36.  
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The Preferences Window
The HX Edit Preferences window is available for all Helix and HX devices. It includes 
three selectable screens to edit application settings and to reference version & legal 
info. This window is accessed by either selecting Preferences from the HX Edit menu 
(Mac), Help menu (Windows), or by clicking on the My Account menu button or con-
nected device indicator at the bottom of the main application window.

The My Account menu and device indicator

At the top of the Preferences window you'll see the firmware version for your connected 
Helix or HX device.* Click the “?” menu button at the top right and you can choose Online 
Help to visit the line6.com site for product info, or select Pilot's Guide to launch the PDF 
you are now reading. Click the buttons at the left of the window to access the desired 
options.

The HX Edit Preferences  window - General Settings screen (Helix device connected)

*NOTE: To check for and install the latest firmware updates for your Helix or HX 
device, use the Line 6 Updater application - see page 48 for details. 

The General Screen
The General screen (as shown above) offers options for your device's Preset and IR 
Libraries. 

Preset Numbering Format - The presets within the Librarian's Presets Panel can 
be numbered as bank numbers & letters (as 01A-32D), or by 000-127 within each 
Setlist, depending on which is more convenient for you.

Stereo IR Import - When a stereo IR .wav file is imported by a Helix or HX device, 
it must be converted to mono. This preference lets you choose whether to take the 
left or right channel of the source IR file, or to sum both channels to mono. The 
default is to import the left channel.
Import Bundle & Export Bundle - (Helix devices only) A Bundle is a file containing 
the complete contents of the Helix device's Preset Library (or, the full Preset Library 
from Helix Native plug-in, if exported from Helix Native). These buttons allow you to 
Import a Helix Bundle file from your hard drive, or create and save all your device's 
setlists and presets in their currently-saved state as a Bundle file to your hard drive. 
Please see “Importing and Exporting Bundles” on page 11 for details.
EXP 2/Ext Amp Option - (Helix LT devices only) Helix LT devices incorporate a 
“shared” EXP PEDAL 2/EXT AMP jack. This option allows you to choose the 
jack's functionality (same as the Helix LT hardware's Global Settings > Preferences 
option).
EXP 1/Amp 1 and EXP 2/Amp 2 Options - (HX Effects devices only) For the HX 
Effects device's two PEDAL/EXT AMP jacks, these options allows you to choose 
their functionality (same as the HX Effects hardware's Global Settings > Prefer-
ences options).
Show/Hide Block Name Labels - If you prefer to have the Signal Flow window not 
show labels beneath each block, you can choose Hide Names here (see page 18)

The About Screen
The About screen provides version information for the HX Edit application.

The HX Edit About box screen (Helix device connected)

The Legal Screen
The Legal screen displays all the necessary trademark, copyright and other legal re-
quired statements for HX Edit.
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Marketplace & 
Account Options
Marketplace

Now open for business is the Line 6 Marketplace online shop, where you'll find 3rd-
party, premium add-on assets that even further enhance the functionality of your Helix 
and HX devices, as well as for Helix Native plug-in! As of this writing, professionally 
crafted presets and IRs are available - check back often on the Marketplace site for 
product news and announcements. As covered within this chapter, you're only a few 
clicks away from using new Marketplace assets on your system, right from the My Ac-
count menu in HX Edit.

NOTE: Version 2.70 of HX Edit and device firmware, and 1.70 of Helix Native (or 
later versions) are required for full support and use of premium Marketplace presets 
and IRs. 

Get Your Marketplace Assets
Access the Marketplace website by choosing the Get More Presets and Get More 
IRs, commands within the My Account menu at the bottom left of the HX Edit window 
(or go directly to https://line6.com/marketplace/). When visiting the Marketplace site, 
simply log in to your Line 6 account, choose the desired pack(s) of presets or IRs, add 
them to your cart, and check out.* 

*NOTE: Be sure to log in to the same Line 6 account on which you've authorized 
your computer for HX Edit and Helix Native to ensure your Marketplace purchased 
assets are added to the correct account!

Once your purchase is complete, your downloadable Marketplace assets are deposited 
into your Line 6 account, which include your personal license that allows you to import 
them on your authorized computer system. Each Marketplace purchase is download-
able as a “zip” file that you'll need to “unzip” on your local hard drive once downloaded.

To download your purchased assets, click on the Manage Account command 
within HX Edit app's My Account menu (or go directly to https://line6.com/ac-
count/), sign in to your account, and select Helix Marketplace from the Hardware 
& Software section at the left.

Licenses for your purchased assets are automatically added to your Line 6 account 
and “synced” the next time you use the HX Edit application, as long as your are 
actively signed in to your Line 6 account from the My Account menu (see “Sign In 
/ Sign Out” on page 34).

Import and Utilize Your Marketplace Assets
An Internet connection is required for the computer where you'll be using the HX Edit 
app to authorize it for the use of Marketplace premium assets, and for the sync with 
your Line 6 account to initially authenticate your newly purchased Marketplace licensed 
assets. Otherwise, an active Internet connections is not required for the use of HX Edit. 
Please see the following sections for details about signing in and authorization.

Once you've signed in and authorized your computer via HX Edit, your premium 
Marketplace presets and IRs can then be imported and used just like any other 
presets and IRs within HX Edit (and/or within Helix Native).
Once imported, premium Marketplace presets and/or premium Impulse Responses 
(.hir files), appear with a golden guitar pick “badge” at their right in the HX Edit librar-
ian lists. (Also see page 10. and page 12 for more about importing presets and 
IRs.)

The golden guitar pick badges indicate premium Marketplace presets and IRs

https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/account/
https://line6.com/account/
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The My Account Menu Options
At the bottom left of the HX Edit application window, you'll see the My Account menu 
and account status indicator. Initially, before you've signed in to your Line 6 online ac-
count and/or authorized your computer for Marketplace premium assets, you'll see this 
menu displayed with the My Account label.

The My Account menu (not signed in or authorized)

Clicking on the My Account menu displays options for accessing the Preferences window 
(see page 32), signing in & managing your Line 6 account, as well as for access to the 
Marketplace online shop.*

*NOTE: It is not required that your computer have an active Internet connection, nor 
do you need to be signed in or authorized at all for the HX Edit app itself to be func-
tional. But signing in is necessary to authorize (or deauthorize) your computer to allow 

the import and export of premium assets purchased from the online Marketplace. 
If you don't plan to use Marketplace premium assets, you don't have to worry 
about signing in and out with HX Edit, and you can simply ignore the following 
Sign In / Sign Out and Authorize / Deauthorize sections. 

Sign In / Sign Out
If you are not currently signed in, choose Sign In from the menu and enter your Line 6  
account user name and password in the Sign In window. If you have forgotten your sign 
in credentials, or have not already created a Line 6 account, choose the Forgot my pass-
word/username or Create a Line 6 account option within the window. If you are already 
signed in and wish to sign out, choose the Sign Out option from the menu.

TIP: If you plan on purchasing premium Marketplace assets, it is easiest to simply 
remain actively signed in, with your computer in the authorized state. This allows the 
licenses for your purchased assets to automatically be “synced” from your Line 6 ac-

count, and for the assets able to be utilized for all actions within the HX Edit app.  

The Line 6 account Sign In window

Computer Authorization Status Indicator
Once you've signed in, your computer is automatically authorized, as confirmed by a pop 
up window letting you know the sign in and authorization were successful. You'll see the 
My Account menu label display your first name (derived from your Line 6 account) and in-
dicate the status of your account sign in and computer authorization (more details about 
authorization in the following section). 
Whenever signed out, the menu button displays the “My Account” label, with no colored 
authorization indicator. 

Signed in with computer Deauthorized

Signed out with computer Deauthorized

Signed in with computer authorized

Once you've authorized your computer, you can optionally sign out, and your computer 
remains in the authorized state, allowing you to continue to perform import, export, copy 
and backup actions with your Marketplace assets, even if your Internet connection is not 
currently active.
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Note that you will need an Internet connection to be able to sign in again to access the 
Deauthorize and Authorize options from the menu, as well as to initially synchronize with 
your online Line 6 account after making any new Marketplace purchase (see “License Syn-
chronization”).

Authorize / Deauthorize Your Computer
It is necessary for your computer to be in the authorized state for performing any HX 
Edit Import, Export, Copy/Paste or Backup/Restore action that includes your pur-
chased Marketplace premium IRs or presets (as well as setlists or bundles that include 
them). Simply signing in to your Line 6 account will authorize your computer automati-
cally.*

*NOTE: It is permitted to authorize a maximum of 4 of your computers concur-
rently. If you've already authorized 4 computers, you can deauthorize one com-
puter to free up one of your authorizations. 

Deauthorizing You Computer
While signed in to your Line 6 account, choose the Deauthorize Computer command 
from the My Account menu and the brief online deauthorization process completes au-
tomatically. You'll see a confirmation dialog appear and the Authorization Status Indica-
tor for the My Account menu will change to red to indicate your deauthorized state (see 
preceding section). Additionally, deauthorizing your computer will also automatically 
sign you out of your Line 6 account.
When deauthorized, the HX Edit application still functions to provide all preset & IR 
librarian and signal flow editing tasks, however, Marketplace-purchased assets are not 
able to be imported or exported with the HX Edit app. You can choose Authorize Com-
puter from the menu to authorize the computer again at any time, providing you have 
not exceeded the 4 computer authorization limit.

Helix Native Plug-in Owners: This authorization/deauthorization within HX Edit 
globally authorizes/deauthorizes your computer for the use of the Helix Native 
plug-in (and the use of Marketplace assets within it) as well, assuming your Helix 

Native license and Marketplace purchases were performed using your same Line 6 
user account. Please also see the Helix Native Plug-in Pilot's Guide. 

License Synchronization
Whenever you make a purchase from Marketplace, a license for each product you 
purchase is deposited into your online Line 6 account. For the HX Edit application to 
access your new licenses and effectively “unlock” your purchased assets, it needs to 
perform a “sync” process with your Line 6 account. You must have an active Internet 
connection and be signed in within HX Edit on your next use of the app after your 
purchase for this license synchronization to occur. 
When you're signed in, this brief sync takes place automatically in HX Edit the next time 
you launch the application, or if already running, when you next click on the HX Edit 
app window. (Note that it may take up to 5 minutes before a sync occurs if HX Edit was 
already running.) Once the license sync has completed, an active Internet connection is 
not required for the use of these Marketplace purchased assets within HX Edit or within 
your Helix hardware.

Manage Account
Choose this menu option to be taken to the Line6.com My Account page, where you 
can view and update your Line 6 user account - view and manage add-ons and Mar-
ketplace purchases, register Line 6 gear, update your personal information, and more.

http://line6.com/support/manuals/
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Keyboard Shortcuts
The following keyboard shortcuts are available to speed up tasks when working in the HX Edit application. Where indicated, some shortcuts require that “focus” be placed on a 
window, panel or specific control to be able to trigger its function. To place focus within the desired window, press your Tab key to cycle focus between the Librarian, Editor and 
Inspector windows - you'll see the window outlined in blue to indicate it now has focus. Whenever the Command Center, Global EQ or Preferences modal windows are opened 
from the app's Window menu, they will automatically have focus. To place focus on a tabbed panel, click directly within the desired Presets, Impulses, Edit or Controller Assign 
panel. To place focus on any block, or on any parameter slider, button or menu list, simply click directly on it to select it, or use the Up/Down and Left/Right arrow keys to navigate 
through blocks, presets, IRs or menu items. 

HX Device Owners: Shortcuts listed in the following tables are the same for use with Helix and HX devices, except where noted. 

Global Shortcuts
Command Mac PC Function - These shortcuts perform the following functions regardless of focus 

Window Focus
(forward)

Tab Toggles focus between the Librarian, Signal Flow and Inspector (as indicated by blue outline of selected window)

Window Focus
(reverse)

Shift + Tab Performs same focus action as above, but rotates through Librarian, Signal Flow and Inspector in reverse order

Enter Tap Tempo T “Tap” the key rhythmically to enter the system Tap Tempo value

Tap Tempo Mode 
Selection

Shift T+ Changes the Tap Tempo Mode Menu selection (Per Snapshot, Per Preset or Global)

File Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Save Command
⌘ S+ Ctrl S+ Saves the currently loaded preset

Import Preset/IR Command
⌘ I+

Ctrl I+ Imports a preset into the 
currently-selected librarian list 
slot

Imports an IR into the currently-
selected librarian list slot

These shortcuts are functional and act upon the 
Presets or Impulses tab, whichever is currently dis-
played within the Library window

Export Preset/IR Command
⌘ E+ Ctrl E+ Exports the currently-selected 

preset
Exports the currently-selected 
IR 

Import Setlist

Command
⌘ I+
+Option

Alt

Alt I+
+Ctrl Imports a setlist, replacing the 

current setlist and its presets
No function These shortcuts are functional whenever the Presets 

tab is currently displayed within the Library window

Export Setlist

Command
⌘ E+
+Option

Alt

Alt E+
+Ctrl Exports the current setlist and 

its presets as a setlist file to 
your computer
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File Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Import Bundle
(Helix devices)

Command
⌘

Shift

I+
+

Shift

Ctrl

I+
+ Imports a bundle, replacing all 

setlists and presets
No function These shortcuts are functional whenever the Presets 

tab is currently displayed within the Library window

Export Bundle
(Helix devices)

Command
⌘

Shift

E+
+

Shift

Ctrl

E+
+ Exports all setlists and their 

presets as a bundle file to 
your computer

Edit Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Cut Command
⌘ X+

Ctrl X+ No function No function Copies the selected block & 
its settings to the clipboard 
and deletes the block from 
the signal flow

No function

Copy Command
⌘ C+ Ctrl C+ Copies the currently-

selected preset (in its last-
saved state) to the clipboard

Copies the currently-
selected IR (with its current 
settings) to the clipboard

Copies the selected block 
(with its current settings) to 
the clipboard

No function

Paste Command
⌘ V+ Ctrl V+ Pastes the last-copied 

preset from the clipboard 
into the selected preset 
location

Pastes the last-copied IR 
from the clipboard into the 
selected IR location

Pastes the last-copied 
block from the clipboard 
into the selected block 
location

No function

Clear Command
⌘ + Delete Delete No function Clears the selected IR 

location(s)
Deletes the block from the 
signal flow

No function

Select All Command
⌘ A+ Ctrl A+ Selects all 128 preset 

locations within the current 
setlist

Selects all 128 IR locations 
within the Impulses list

No function No function

Rename Command
⌘ R+ Ctrl R+ Allows the selected preset 

to be renamed
Allows the selected impulse 
to be renamed

Allows the currently loaded preset to be renamed

Window Menu Commands - Shortcuts
Command Mac PC Presets or Impulses Tab Focus Signal Flow Panel Focus Inspector Window Focus
Show/Hide Librarian Panel

Command
⌘

Shift

L+
+

Shift

Ctrl

L+
+ Shows or hides the Preset/Impulses Librarian Panel

Command Center
(Helix & HX Effects)

Command
⌘

Shift

M+
+

Shift

Ctrl

M+
+ Opens (and places focus in) and closes the Command Center window

Global EQ
(Helix devices)

Command
⌘

Shift

G+
+

Shift

Ctrl

G+
+ Opens (and places focus in) and closes the Global EQ window 
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Snapshots Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus
Copy

Command
⌘

Shift

C+
+

Shift

Ctrl

C+
+ Copies the currently loaded snapshot to the clipboard

Paste

Command
⌘

Shift

V+
+

Shift

Ctrl

V+
+ Pastes the last-copied snapshot contents from the clipboard into the current snapshot 

Rename

Command
⌘

Shift

R+
+

Shift

Ctrl

R+
+ Allows you to enter in a new title to rename the current snapshot

Snapshot 1
(All Helix & HX 
devices)

Command
⌘ 1+ Ctrl 1+ Loads Snapshot 1 

Snapshot 2
(All Helix & HX 
devices)

Command
⌘ 2+ Ctrl 2+ Loads Snapshot 2

Snapshot 3
(All Helix & HX 
devices)

Command
⌘ 3+ Ctrl 3+ Loads Snapshot 3

Snapshot 4
(Helix & HX Effects 
devices)

Command
⌘ 4+ Ctrl 4+ Loads Snapshot 4

Snapshot 5 
(Helix devices) Command

⌘ 5+ Ctrl 5+ Loads Snapshot 5

Snapshot 6
(Helix devices) Command

⌘ 6+ Ctrl 6+ Loads Snapshot 6

Snapshot 7
(Helix devices) Command

⌘ 7+ Ctrl 7+ Loads Snapshot 7

Snapshot 8
(Helix devices) Command

⌘ 8+ Ctrl 8+ Loads Snapshot 8

Librarian Window - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus

Presets Tab P Displays and changes focus to the Presets tab No function

Impulses Tab I No function Displays and changes focus to the Impulses tab
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Librarian Window - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus

Display Context 
Menu Ctrl +

or

or
Shift + Return

Enter

or
Shift + Return

Enter

Displays the context menu for selected preset location
(Navigate an open menu using Up/Down Arrow keys and 
ENTER key to make selection. Use ESC key to dismiss 
menu.)

Displays the context menu for selected IR location
(Navigate an open menu using Up/Down Arrow keys and 
ENTER key to make selection. Use ESC key to dismiss 
menu.)

Change Tab Focus Changes focus between the Presets and IR tabs Changes focus between the Presets and IR tabs

Navigate Selection Navigates the preset selection within the current setlist Navigates the IR selection within the Impulses list

Extend Selection
Shift + Extends the preset selection within the current setlist Extends the IR selection within the Impulses list

Contiguous Multi-
select Shift + Selects contiguous multiple presets within the current 

setlist
Selects contiguous multiple IRs within the Impulses list

Non-contiguous 
Multi-select Command

⌘ + Ctrl + Selects non-contiguous multiple presets within the current 
setlist

Selects non-contiguous multiple IRs within the Impulses list

Rename Preset/IR

Delay click

Renames the clicked preset (click once and then a 2nd time 
1/3 of a second or later)

Renames the clicked IR (click once and then a 2nd time 1/3 
of a second or later)

Rename Setlist
(Helix devices)

R Renames the current setlist No function

Setlist 1
(Helix devices)

1 Displays Setlist 1 No function

Setlist 2
(Helix devices)

2 Displays Setlist 2 No function

Setlist 3
(Helix devices)

3 Displays Setlist 3 No function

Setlist 4
(Helix devices)

4 Displays Setlist 4 No function

Setlist 5
(Helix devices)

5 Displays Setlist 5 No function

Setlist 6
(Helix devices)

6 Displays Setlist 6 No function

Setlist 7
(Helix devices)

7 Displays Setlist 7 No function

Setlist 8
(Helix devices)

8 Displays Setlist 8 No function
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Signal Flow Window - Shortcuts
Command Mac PC Function - These shortcuts perform the following functions when the Signal Flow window has focus

Navigate Selection Selects and cycles through blocks within the Signal Flow 

Edit Tab Return
Enter Activates the Edit tab, displays the edit options for the selected block, and gives focus to the Model Category of the 

selected block's model
Display Block 
Context Menu Shift + Return

Enter

or  Ctrl +

or  

Shift + Return
Enter

or  

Displays the block's context menu*

Block Bypass 
Toggle

Spacebar Toggles the bypass state of  the selected block

Amp Block Select
(Helix & HX Effects 
devices)

A Selects and cycles through selecting the Amp, Amp+Cab and Preamp blocks in the current preset

Block Select
 Single-click

Selects a block or empty block location

Display Edit tab - 
Model Browser  Double-click

Double click on any block or empty block location to display the Model Browser to choose a model

*Open context menus can be navigated by arrow keys, where ENTER makes a selection, and ESC dismisses the open menu.

Inspector Window - Shortcuts
Command Mac PC Edit Tab Focus* Bypass/Controller Assign Tab Focus
Edit Tab E  or  H No function Displays and places focus on the Edit tabbed panel

Bypass/Controller 
Assign Tab

B  or C Displays and places focus on the Bypass/Controller 
Assign tabbed panel

No function

Select Previous/Next 
Parameter or List

Advances the focus to the previous or next parameter 
slider or list
(If Model Grid view is visible, Shift must be used to 
advance focus out of Model Grid - see next shortcut)

No function

Select Previous/Next 
Tabbed List

Shift + Advances the focus to the first parameter on the previ-
ous or next tabbed list (if Amp+Cab or Dual Cab, or if 
Variax input parameters are present)

No function

Snapshot Assign Alt + Click directly on any parameter slider to quickly assign 
its value to a Snapshots controller (or, when a param-
eter slider has focus, press S).

No function

Display Context 
Menu Shift + Return

Enter

or  Ctrl +

or  

Shift + Return
Enter

or  

Display the context menu for the selected parameter 
slider 

Display the context menu for the selected Bypass or 
Controller Assignment within the Assignments list 
(Note that the Shift+Enter shortcut does not work within 
this tab, but right click actions do)
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Inspector Window - Shortcuts
Command Mac PC Edit Tab Focus* Bypass/Controller Assign Tab Focus

Reset to Default
Command

⌘ + Ctrl + Click on any parameter slider to reset it to its default 
value (or, when a parameter slider has focus, press D).

No function

Toggle Model List 
and Grid Views

G Toggles between displaying the Category/Model List 
View and Model Grid View

No function

*Focus within the Edit tab is indicated by turquoise colored outline surrounding a Model Browser item, or vertical line at left of parameter sliders. See next section for more details.

Edit Tab - Model Browser Shortcuts
There are numerous keyboard shortcuts available for working within the multi-level Model 
Browser of the Inspector's Edit tab. The functionality of these shortcuts is dependent 
upon the element within the Edit tab that currently has focus, as described below. 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders

Within the Model Browser, the element that currently has focus is indicated by a tur-
quoise colored outline. You can set the focus by either clicking to select an item within 
the list, or use your Up/Down/Left/Right arrow keys.

Model Focus (List View)

Model Category 
Focus 

Model Focus (Grid View)

Slider Focus 
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Edit Tab: Category List or Model/Grid List Focus Shortcuts
Mac or PC Function 

Changes category or model selection

Moves focus between Category List, Model List and Parameter 
Sliders
(If Model Grid view is visible, Shift must be used to advance focus 
out of Model Grid)

Shift + For navigation when the Model Grid View is in use - Moves focus to 
the first parameter slider

Shift + For navigation when the Model Grid View is in use - Displays the 
Model Category Menu 
(Use Up/Down Arrow keys and ENTER keys to navigate and select 
Category within menu)

G Toggles between displaying the Category/Model List View and 
Model Grid View

Shift D+ Selects Distortion category

Shift Y+ Selects Dynamics category

Shift Q+ Selects EQ category

Shift M+ Selects Modulation category

Shift L+ Selects Delay category

Shift R+ Selects Reverb category

Shift S+ Selects Pitch/Synth category

Shift F+ Selects Filter category

Shift W+ Selects Wah category

Shift A+
+Option

Alt Selects Amp+Cab category (Helix and HX Stomp devices)

Edit Tab: Category List or Model/Grid List Focus Shortcuts
Mac or PC Function 

Shift A+ Selects Amp category (Helix and HX Stomp devices)

Shift C+ Selects Cab category (Helix and HX Stomp devices)

Shift P+ Selects Preamp category (Helix and HX Stomp devices)

Shift I+ Selects IR category

Shift V+ Selects Volume/Pan category

Shift N+ Selects Send/Return category

Shift O+ Selects Looper category

Edit Tab: Parameter Slider Focus Shortcuts
Mac or PC Function 

 or  
_
-

+
=

Increments/decrements parameter value - fine adjustment

Shift + _
-

+
=

Shift +

or

Increments/decrements parameter value - coarse adjustment

Return
Enter Edits numerical parameter value or shows drop-down menu for 

discrete parameter choices. (Navigate an open menu using Up/
Down Arrow keys and ENTER key to make selection. Use ESC key 
to dismiss menu.)

Shift
+
Return
Enter

Opens the selected slider's context menu for controller assignment 
options
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Edit Tab: Parameter Slider Focus Shortcuts
Mac or PC Function 

N For “Note Sync” capable parameters (indicated by the  button to 
the right of the slider), this toggles the functionality between Note 
Sync and Absolute Time

D Sets the selected parameter to its default value

S For model parameters, assigns parameter to a Snapshot controller

Double-click Enters edit mode for numerical parameter value (tap Enter/Return 
key to accept edited value)
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Command Center, Global EQ & Preferences Window Shortcuts
(Helix and HX Effects devices only) Focus within these windows is indicated by the turquoise colored outline surrounding a control, or by the vertical line at left of any parameter slider.

Command Center Window - Shortcuts
Command Mac PC Function 
Any Control Has Focus

Open/Close 
Command Center

Command
⌘

Shift

M+
+

Ctrl

Shift

M+
+ Opens and closes the Command Center Window 

You can alternatively use ESC to close the open Command Center window

Focus Next Tab Move focus to next command parameter

Focus Previous Shift + Tab Move focus to previous command parameter

Parameter Slider Focus

Adjust Parameter  
Value - Fine

 or  
_
-

+
=

Adjusts the selected parameter slider's value up or down using small increments

Adjust Parameter  
Value - Coarse

Shift + _
-

+
=

Shift +

or

Adjusts the selected parameter slider's value up or down using large increments

Edit Numerical 
Parameter Value Return

Enter Edits the selected parameter's numerical value, or displays a parameter's drop-down menu for parameter options

Customize Label Control Focus

Edit Custom Label Return
Enter Edits the text within the Customize label field to create a custom name for any Footswitch label

Remove Custom 
Label

Delete Deletes the text within an edited Customize label field and returns it to its default label

Controller Grid Focus

Select Controller 
Within Grid

When any Controller (Instant, Footswitch , Variax Knob or EXP Pedal) has focus within the Grid pane - Moves the se-
lection to the next or previous Controller
(Use TAB to place focus on Command menu and then use Arrow keys to choose Command option)

Command Menu Focus (as indicated)

Command Menu 
Option Selection

_
-

+
=or

When the Command Menu has focus, but the menu is not opened - chooses the next or previous option within the 
Command menu. Once the desired command within the menu list is highlighted, press the ENTER key to choose the 
command



 45 

Command Center Window - Shortcuts
Command Mac PC Function 

Open Command 
Menu Return

Enter When the Command Menu has focus, but the menu is not opened - use the ENTER key to open the menu, and then 
use the following shortcut keys to choose a command from the open menu list. 

Dismiss Command 
Menu

Esc When the Command Menu has focus and is opened - use the ESC key to close the menu without making a selection

Change Command 
Menu Selection

When the Command Menu has focus and is opened - use the Up/Down Arrow keys to highlight the desired com-
mand in the menu list, then use the ENTER key to select the highlighted command

Global EQ Window - Shortcuts (Helix  and HX Stomp devices)
Command Mac PC Function 
Any Control Has Focus

Open/Close Global 
EQ 

Command
⌘

Shift

G+
+

Ctrl

Shift

G+
+ Opens and closes the Global EQ Window. 

You can alternatively use ESC to close the open Global EQ window.

Focus Next Tab Move focus to next control

Focus Previous Shift + Tab Move focus to previous control

Reset R Invoke the Reset button to set all parameters “flat”

Apply EQ
(Helix devices)

A Cycle through the Apply EQ menu's output modes

Bypass B Toggle Bypass on/off 

EQ Graph Pane Focus

Low Cut 1 Selects the Low Cut node

Low Peak 2 Selects the Low Peak node

Mid Peak 3 Selects the Mid Peak node

High Peak 4 Selects the High Peak node

High Cut 5 Selects the High Cut node

Adjust Edit Node -
Fine

Adjusts the selected edit node in small increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency
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Global EQ Window - Shortcuts (Helix  and HX Stomp devices)
Command Mac PC Function 

Adjust Edit Node -
Coarse

Shift + Tab Adjusts the selected edit node in large increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency

Increment Q Value 
- Fine

Q Increments the selected node's Q parameter value by 0.1

Increment Q Value 
- Coarse Shift Q+ Increments the selected node's Q parameter value by 1.0

Decrement Q Value 
- Fine Ctrl Q+ Decrements the selected node's Q parameter value by 0.1

Decrement Q Value 
- Coarse

Shift

Ctrl

Q+
+ Decrements the selected node's Q parameter value by 1.0

Control-Specific Focus (as indicated)

Reset Return
Enter When the Reset button has focus - Resets all parameters to default “flat” values

Bypass Spacebar When the Bypass button has focus - Toggles Global EQ Bypass

Close Window Return
Enter When the Done button has focus - Triggers the Done button to exit the Global EQ window. Optionally, you can use the 

ESC key to close the window
Apply To
Output Options
(Helix devices)

_
-

+
=or

When the Apply To output menu has focus - Selects the Apply To output menu's next or previous option. Optionally, you 
can use the ENTER key when the menu has focus to expand and view the menu list

Preferences Window - Shortcuts
Command Mac PC Function 

Close Window Return
Enter

 or

Command
⌘ + <,

Return
Enter When the Preferences window is open, triggers the Close button to exit the window. You can also use the ESC key to 

close the window
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Additional Mouse Behaviors
But wait, there's more! To follow are additional time-saving gestures using your mouse 
buttons or mouse wheel. 

•	 Hover your mouse cursor over any block within the Signal Flow to access the 
block’s Bypass and Clear buttons.

•	 Hover your mouse cursor over any parameter slider and adjust its value.
•	 Hover your mouse cursor over any scroll bar to scroll the panel's contents, such as 

within the Presets and Impulses lists and Edit and Bypass/Controller Assign tabs
•	 Left-click and hold the mouse button or right-click on the Preset tab's Setlist menu 

to rename the current Setlist.
•	 Use your mouse wheel while hovering the mouse cursor over the Setlist menu to 

load a different Setlist. 
•	 Left-click and hold the mouse button or right-click on the Snapshots menu to 

rename the current Snapshot.
•	 Use your mouse wheel while hovering the mouse cursor over the Snapshots  menu 

to load a different Snapshot.
•	 Left-click and hold the mouse button or right-click on the numerical Tap Tempo 

control to edit the tempo value.
•	 Use your mouse wheel while hovering the mouse cursor over the numerical Tap 

Tempo control to increment/decrement the tempo value.
•	 In the Signal Flow window, drag a block in any direction out of its signal path until 

you see the “Drag-delete” indicator appear, then “drop” the block to delete it.
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Line 6 Updater & 
Additional Resources

Using Line 6 Updater
The Line 6 Updater application is the free utility to use to easily install the latest firmware 
onto Line 6 products. The Line 6 Updater software is installed automatically on your 
computer with the installation of the HX Edit application - or the latest version can be 
downloaded anytime from http://line6.com/software/

TIP: It is always a good idea to create a backup of your Helix or HX device's con-
tents before performing a firmware update! The best procedure is to perform the 
backup in your existing HX Edit version first - then update to the latest device firm-

ware and HX Edit versions. See “Creating & Restoring Complete Device Backups” on 
page 16.

To use the Line 6 Updater application - With your Helix or HX device connected and 
powered on, quit all other Line 6 and audio applications and launch the Line 6 Updater 
application.

•	 On Mac - Go to Applications > Line 6 > Line 6 Updater
•	 On Windows® - Go to the Start button menu > All Apps (or Programs) > Line 6 > 

Line 6 Updater

Once launched, you will be asked to sign into your Line 6 account. If you do not have 
an account, you must first create one. Follow the prompts through to the quick online 
registration.
Once logged in, any USB-connected and supported Line 6 products will appear in the 
main view of the Line 6 Updater application. Click on the device you wish to update and 
your device's current firmware version and available updates are displayed.
Click the Update button for the desired firmware version. The release notes are shown 
before continuing with the update process. Click Accept and accept the terms and con-
ditions to start the update process.

You'll see the firmware's Release Notes and special instructions displayed before update 
begins. Be sure to read all screens and prompts carefully and the Line 6 Updater soft-
ware will assist you in performing the update in minutes. It is especially important not 
to disturb the device’s controls and cable connections until the update fully com-
pletes!
While the presets on your device will not be altered, some minor sonic changes may still 
occur with firmware updates, as noted within any firmware's Release Notes. 

TIP: Whenever installing firmware, you must be sure to also install the matching ver-
sion number of the HX Edit application. Please visit http://line6.com/software/ to find 
the correct application version.

Additional Resources
Looking for more info? We’ve got plenty of online resources, just a click away.

•	 Additional Help documentation covering Helix & HX hardware and Helix Native 
Plug-in is available on the Line 6 Support site at Line 6 Product Manuals. 

•	 Visit the Line 6 CustomTone site where you can share your presets with the 
world, and download free presets created by Line 6 and other users just like you.

•	 Looking for some professionally crafted presets and Impulse Responses for your 
Helix device or Helix Native plug-in? Check out the new Marketplace, and be 
sure to check back often for news and product announcements.

•	 Can’t get enough Line 6 Gear & accessories? Head on over to the Line 6 Online 
Shop.

•	 Check out the Line 6 Support page for access to helpful tips, videos, discussion 
forums, or to contact Line 6 Technical Support.

http://line6.com/software/
http://line6.com/software/
http://line6.com/support/manuals/
http://line6.com/customtone/
https://line6.com/marketplace/
https://shop.line6.com/
http://line6.com/support


®


	HX Edit Pilot's Guide
	Workflow
	What’s in it for Me?
	Marketplace
	Workflow Overview
	Computer Connectivity
	Multi-Device, Multi-Window Support

	Preset Compatibility
	Preset Compatibility with Helix Native Plug-in

	GUI Overview
	Resizing the Application Window
	Application Menus

	Presets Panel
	Premium Marketplace Presets
	Selecting & Loading Presets
	Importing and Exporting Preset Files
	Renaming, Reordering, Copying and Pasting Presets
	Importing and Exporting Setlists
	Importing and Exporting Bundles

	Impulses Panel
	What are Impulse Responses?
	Importing and Exporting Impulse Responses
	Renaming, Copying, Pasting & Clearing IRs

	Working in the Editor
	Naming & Saving the Preset
	Configuring & Managing Snapshots
	Editing the Tap Tempo
	Creating & Restoring Complete Device Backups

	The Signal Flow Window
	Moving Blocks & Arranging the Signal Flow
	Split Path Options
	Cutting, Copying, Pasting & Clearing Blocks
	Drag and Drop Blocks
	Adding & Bypassing Blocks

	The Edit Tab
	Selecting Models
	Editing Model Parameters
	Editing Input, Output, Split & Mixer Blocks

	The Bypass/Controller Assign Tab
	Editing an Existing Assignment
	Clearing Existing Assignments
	Creating a Bypass Assignment
	Creating a Controller Assignment

	The Command Center Window
	Creating a Command Center Assignment
	Customizing a Footswitch Label
	Customizing a Footswitch LED Color

	Global EQ Window
	Adjusting Global EQ Parameters

	The Preferences Window
	The General Screen
	The About Screen
	The Legal Screen

	Marketplace & Account Options
	Marketplace
	The My Account Menu Options
	Sign In / Sign Out
	Authorize / Deauthorize Your Computer

	Keyboard Shortcuts
	Command Center, Global EQ & Preferences Window Shortcuts
	Additional Mouse Behaviors

	Line 6 Updater & Additional Resources
	Using Line 6 Updater
	Additional Resources




